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Copyright 

This documentation is protected by law. All rights, especially the right of 
duplication, circulation, and translation, are reserved. 

No part of this publication may be reproduced in the form of copies, 
microfilms or other processes, or transmitted into a language used for 
machines, especially data processing machines, without the express written 
consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. 
Errors in and changes to the contents as well as program modifications 
reserved. 

MAGIX and Cleaning Lab are registered trademarks of MAGIX AG. 

VST is a registered trademark of Steinberg Media Technologies GmbH. 

MAGIX Audio Cleaning Lab uses patent-pending technology. 

Other mentioned product names may be registered trademarks of the 
respective manufacturer. 

MAGIX licensing conditions are included in the installation and also at 
www.magix.com under EULA 

Copyright © MAGIX AG, 2000-2011. All rights reserved. 

Legal notice: Copyrights and laws against exploitation of accomplishments of 
artists and publishers shall be observed. 
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Preface 

Congratulations! You now own a high-performance digital audio lab, which is 
perfect for cleaning your records, tapes, CD tracks, MP3 collections, audio or 
video files, enhancing the sound, combining your media in any order, and 
burning or exporting everything in optimum quality directly onto CD or DVD. 

The volume and sound on each track can be perfectly synced and equalized. 
Various audio formats can be combined, simultaneously edited, and burned. 
The method is especially easy and clear, since automatic settings, assistants 
and step-by-step instructions make sure that the process goes smoothly and 
easily. Neither previous experience using the software nor long processing 
time are necessary. 

The print manual provides an introduction and tutorial that explains all the 
most important features with step-by-step instructions.  

In addition, an electronic manual is supplied in PDF, which systematically 
explains all of the program's components one after the other. You can also 
use the program's help file by pressing "F1". If you prefer to discover the 
many possibilities of the program by yourself, then use the PDF manual and 
help file simply as a reference. An alphabetical index is included for this 
purpose. 

Have fun with MAGIX Audio Cleaning Lab MX. 

The MAGIX team. 
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Before You Start 

Package contents 

Program CD 

The MAGIX Audio Cleaning Lab MX installation manager is included on this 
CD. 

Printed manual 

The print manual contains all necessary information for a quick start with the 
program. It includes installation hints, a quick introduction (tutorial), and an 
overview of the functionality of the program with useful hints & tips. 

Hint: The complete documentation is included in the MAGIX Audio Cleaning 
Lab MX folder as a PDF file. You can read it on your screen or print it. You will 
need the "Adobe Acrobat Reader" application, and you can download it for 
free from the Internet if it is not yet installed on your PC. 

System requirements 

Operating system: 

For Microsoft® Windows® XP | Vista® | 7 

Computer: 

 1 GHz processor or higher 
 512 MB RAM 
 500 MB free hard disk space 
 graphics card: resolution 1024 x 768 
 16-bit sound card 
 CD-ROM drive 

Optional: 

 Burn CDs/DVDs with CD/DVD±R(W) recorder 

Installation 

Step 1: Insert the program disc into the drive. The installation program starts 
up automatically in Windows. If the disc doesn't run automatically, 
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 open the Windows Explorer and click the letter of the CD/DVD drive. 
 Now double-click on "Start.exe" to start the installer. 

Step 2: To begin the installation of MAGIX Audio Cleaning Lab MX, click on 
"MAGIX Audio Cleaning Lab MX". The MAGIX Audio Cleaning Lab MX 
installation program will appear. 

Simply follow the instructions on screen to complete the installation process 
and then click on "Continue". All files are copied onto the hard drive. 

Step 3: Once the installation is complete, confirm the message by pressing 
"Finish". You will then be able to start the program at any time from the 
Windows "Start" menu. 

If you would like to uninstall MAGIX Audio Cleaning Lab MX, you can do so via 
the control panel under "Software". Or go to "Programs > MAGIX > MAGIX 
Audio Cleaning Lab MX > Service and Support > Uninstall MAGIX Audio 
Cleaning Lab MX". 
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Support 

Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. 
To this end, we offer a wide range of services: 

 Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at www.magix.com 

 The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 120,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials 
and a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

 Email support for MAGIX products:  
For every new MAGIX product you will receive, as of date purchase, 12 
months of email based customer service. 
Premium email support: 
For priority support, or if you want the MAGIX support team to help with 
non-MAGIX related hardware problems you can purchase a Premium email 
support ticket. Log in at http://support.magix.net and click on "Purchase 
access code", the ticket is for a specific problem, and is valid until it is solved, 
it is not restricted to an email. 

Please note: To be able to use the Premium email support and free product 
email support via the Internet, you have to register your MAGIX product using 
the serial number provided. This can be found on the CD case of your 
installation CD or on the inside of the DVD box. 

 Additional telephone service: 
Besides the large number of free customer service offers, we also offer a 
fee-based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 
Dresden, Germany 

http://support.magix.net/�
http://support.magix.net/�
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Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, 
Reno, NV 89502, USA 

Please make sure you have the following information at hand: 
 Program version 
 Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
 Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the 
following questions and problems: 

 Orders 
 Product consulting (pre-purchase) 
 Upgrade requests 
 Returns 

Europe 

Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 45 699 18763 
Sweden: 46 852 500713  
Finland: 35 89 42419023 
Norway: 47 210 35843 

North America 

9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  

Uninstalling the program 

If you would like to uninstall MAGIX Audio Cleaning Lab MX, you can do so via 
the control panel under "Software". Or go to "Programs > MAGIX > MAGIX 
Audio Cleaning Lab MX > Service and Support > Uninstall MAGIX Audio 
Cleaning Lab MX". 
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Serial Number 

A serial number is included with each product. This serial number is required 
for the installation of the software and enables usage of additional bonus 
services. 

What can a serial number do? 

A serial number ensures that your copy of MAGIX Audio Cleaning Lab MX is 
clearly assigned to you and only you, and it makes improved and more 
targeted customer service possible. Abuse of the software can be prevented 
with a serial number, since it ensures that the optimum price/performance 
ratio continues to be offered by MAGIX. 

Where can the serial number be found? 

The serial number can be found on the reverse side of your CD/DVD case. If 
your product, for example, is packed in a DVD box, then you'll find the serial 
number on the inside. 

For versions that have been especially optimized for the Internet (download 
versions), directly following the transaction you'll receive a serial number by 
email to activate the software. 

When will you need the serial number? 

The serial number is required when you start or register MAGIX Audio 
Cleaning Lab MX for the first time. 

Note: We explicitly recommend registering your product, since only then are 
you entitled to get program updates and contact MAGIX Support. Entering the 
serial number is also required for activating codecs. 
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More about MAGIX 

MAGIX Online World 

Everything you need for your website 

 Easily create your own website with MAGIX 
website software 

 

 Publish your website for free with the MAGIX free web hosting service 
 Register your domain name of choice for your website at a great price 

Discover MAGIX Online World at www.magix-online.com 

magix.info 

Do you have questions, need help, or are looking for expert tips and tutorial 
videos on your MAGIX product? At magix.info you will find answers and 
solutions as well as workshops and a comprehensive user forum for software 
and multimedia queries. 

You can access magix.info online at www.magix.info 
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Introduction 

What is MAGIX Audio Cleaning Lab MX? 

MAGIX Audio Cleaning Lab MX is a gentle but powerful cleaner for all kinds of 
acoustic material including records, tapes, CD tracks, recorded speech, video 
sound, and MP3s. Digital cleaning features remove everything from light 
cloudiness to the worst sound abominations on noise-filled tapes, scratched 
records, and on MP3s that have been compressed to death. A fine polish of 
the sound brings new life to every song and the burning function encapsulates 
your sensitive sound material on audio or data CD, protecting it from any 
further damage. 

Individual tracks, even individual passages within a track can be given their 
own effect settings. In addition, the entire sound can be cleaned up, refreshed 
and – especially important for compilations – the volume can be balanced. 

MAGIX Audio Cleaning Lab MX is fast, easy-to-use and very gentle: Nearly all 
effects are calculated in realtime during playback without damaging the 
recorded material in the least. The original recordings and songs remain 
untouched on the hard drive. You can therefore experiment to your heart's 
content without having to worry about causing any lasting damage to your 
audio material. 

What’s new in MAGIX Audio Cleaning Lab MX? 

Over 60 new presets 

In the effect modules over 60 new presets are available for quick, effective 
sound optimization for: 

 Background city noise 
 Annoying PC fan noise 
 Airplane, train and traffic noises 
 Disturbing rain and wind noises 

The presets can be found in the effects' selection menu in the "Cleaning" 
section. 

Master reverb & echo 

The reverb or echo effect can be applied to the entire audio material. You can 
find it in the "Cleaning" section. 
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Turbo tape function 

Cassette recordings in double speed (High Speed Dubbing) can now be 
recorded at the normal speed. The accompanying function "Double Speed 
Recording" can be found in the Recording dialog. 

MX 

The "MX" in the title refers to the new media exchange function 
("Media-X-change). In the "Share" menu you will find different options which 
make the current project's audio files available for other applications. You can 
add them to the music collection, use them as a background for slideshows or 
videos or publish online. What's more they can be backed up on mobile 
devices like Smartphones, SD cards or external hard drives. 

Features 

Import 

You can either import existing audio files in many conventional formats into 
MAGIX Audio Cleaning Lab MX, or simply use MAGIX Audio Cleaning Lab MX 
to record your own music. No matter whether cassette, tape reel, LP, or via 
streaming Internet, with only a few clicks, you can digitize your music and edit 
it further with MAGIX Audio Cleaning Lab MX. 

Cleaning 

The heart of MAGIX Audio Cleaning Lab MX is its ability to remove unpleasant 
noise in music and enrich the overall sound. To do this, there are numerous 
professional tools available like the "DeClicker", "DeCrackler", "DeClipper", 
"DeNoiser" (including DeRumbler preset), "DeHisser", and "spectral cleaning". 
You can also add a number of sound effects to your music. Resampling and 
timestretching help adjust the speed and pitch of pieces so that they match, 
and reverb/echo adds professional reverb to your music. The possibilities are 
nearly endless, as you will see. For more detailed information about the tools, 
please read MAGIX Audio Cleaning Lab MX's help file. 

Mastering 

So that your recordings sound optimal, a selection of mastering tools are 
available to you once you have cleaned up the audio material. Try them out 
yourself to see which settings are the best, or let MAGIX Audio Cleaning Lab 
MX do the work for you by searching for the best settings automatically. For 
more detailed information about the tools, please read MAGIX Audio Cleaning 
Lab MX's help file. 
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Export 

Of course, you can also export your recordings. There is a wide range of 
formats available which enable you to enjoy your recordings anywhere you 
like. 

Supported formats 

Import:  
Audio: WAV, MP3, WMA, AIFF, OGG Vorbis, M3U, CUE, CD-A, FLAC, AAC 
Video sound import: AVI, WMV, MXV, MOV, DV-AVI, MPEG-22 

Export: 
Audio: WAV, MP31, MP3 Surround1, WMA, AIFF, OGG Vorbis, CD-A, FLAC, 
AAC2, Audio-DVD, Data-DVD 
Video sound export: AVI 

1) Activate MP3 encoder for free 
²) Fee-based activation 
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Tutorial 

In this chapter, we introduce all the most important features of MAGIX Audio 
Cleaning Lab MX. You don't need any special experience; just some time for 
recordings and hard drive space. 

With MAGIX Audio Cleaning Lab MX you can load audio material from a 
number of different sources into projects in order to clean it up, edit it, export 
it as an audio file/CD or burn it to disc using just some of the special functions 
that come in the package. 

First of all, you'll need suitable audio material. You can load your records or 
tapes, or even, for example, audio files from the Internet as MP3s. 

Analog material like records or tapes have to be digitized first so that it can be 
processed by the computer. The recording function in MAGIX Audio Cleaning 
Lab MX can be used for this purpose. It's used to record analog material via 
the computer's sound card. 

Program start 

After starting the program, a selection dialog including several tasks will 
appear. 

 

Choose from:  

 Restore vinyl sound: for LPs. 
 Clean tape sound: for tapes. 
 Optimize voice and audio book recordings: for speech. 
 Edit digital files: for MP3 files, web radio recordings and many more. 
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For all these options you will require relevant material. In the following we 
assume that you already possess digitized material which you would like to 
free from any bothersome noise. 

Note: If you wish to digitize an LP, you should use a USB phono pre-amp in 
order to connect your record player to your PC. By doing so, you ensure best 
sound quality all the way through. You can find a suitable USB phono pre-amp 
in our MAGIX Online Shop at www.magix.com. 

Load and play audio files 

After choosing a suitable task, MAGIX Audio Cleaning Lab MX will show up 
with an empty project window. You are in the "Import" section, which is 
recognizable by the lit button below the project window. 

 

The workflow in this section is very easy:  

 You can load your audio files, e.g. in MP3 format by clicking the "Audio files" 
button. 

 You can record LPs or tapes via the "Record" button. 
 You can import audio CDs via the "CDs" button. 

After import, a waveform display of the audio track appears in the main 
window.  
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The waveform display gives you an idea of the audio track's progression. You 
can even detect noises. Crackling for instance creates a clearly visible peak in 
the waveform. 

Below to the right, you will find the transport controls for playback, stop and 
winding. You will be familiar with these functions from other playback devices. 

 

Use the mouse for quicker navigation: If you click into the waveform display 
with the mouse, the playback marker will be moved exactly to this position. 
You can start and stop the track by pressing the spacebar of your keyboard. 

Cleaning 

There are many types of noises. Let's start with the easiest ones: constant 
humming or irritating hissing. This kind of noise is usually caused by tape 
recorders, record players or microphones and are audible throughout the 
complete track. Find out how to get rid of these irritating distortions: 

  Switch to the "Cleaning" section. 

 

Most of the elements that are displayed here are identical to the ones in the 
"Import" section, but the function area in the lower left hand corner has 
changed decisively. Six different functions for removing audio disturbances are 
available here, which are adjusted differently depending on your selection in 
the start dialog. The modules are "DeClicker", "DeCrackler", "DeClipper", 
"DeNoiser", "DeHisser" and "Spectral Cleaning". If you click on one of these 
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modules, you will find explanations regarding purpose and workflow of the 
individual module on the info monitor located in the bottom right-hand corner. 

 

The slider lets you regulate the 
strength of all of the "cleaning" effects 
(except for Spectral Cleaning, which 
we will deal with later). 

If you are not satisfied with the presets 
of the start dialog, you can choose 
further presets using the arrow menu. 

 

To get an idea of how the selected 
effect affects your audio material, you 
can turn it on and off by clicking on 
the symbol in the left-hand corner. 

 

Click on the symbol in the bottom 
right- hand corner to open a user 
interface where you can set all of the 
available parameters for the effect.  

In a way, this symbol represents the effect's engine hood. The interface 
located behind it was designed to simulate professional audio editing devices. 

 

Depending on the effect device, you can specify very effective audio editing 
settings here. To do so, it's necessary to know a bit about audio editing 
though. Usually, however, you will not need these special functions, but they 
can be useful in complex cases. If you need them or if you're interested, 
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please read the complete documentation (either the PDF manual or the 
program's help file). 

Mastering 

"Mastering", the second effects area aims at optimizing the audio material.  

 Click on the "Mastering" button. 

 

You will find the following effects modules here: "StereoFX", "Equalizer", 
"Brilliance", "Sound Cloner", "Dynamics", "Multimax", "Reverb / Echo", 
"Energizer" and "Chorus". 

The functionality of the optimization effects is the same in principle: Adjust the 
strength of the effect via the slider, switch the effect on and off to compare the 
original with the edited audio material and access the actual operation console 
by clicking on the symbol in the bottom right-hand corner. 

Object effects 

If you combine the audio material from various sources, it's normally not 
sensible to apply cleaning and mastering effects to all objects in the same 
way. Tape recordings usually have other distortions than those known from LP 
recordings. That's why there are two effect usage options: Master effects and 
object effects. 

The master effects are set centrally in the cleaning section. The settings made 
here are applied to the entire sound, i.e. for all objects in the master track. 
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Each object can also have its own individual 
effect settings. Click on "Object FX" on the object 
itself in the master track. 
The "Object FX" screen (object editor) opens in a 
new dialog and displays additional effect devices. 
These effects can be set for every object in the 
master track separately. 

The “Object FX” dialog in the Mastering section contains an echo/reverb 
device for adding Surround Sound to individual objects, and in addition to the 
multi-band compressor (“MultiMax”), a “simple” compressor is also included 
(“Dynamics”). 

Spectral Cleaning 

Up until now, the workflow was extremely easy: load your material, adjust your 
effects – finished. Now let's take a look at an application that requires a bit 
more preparation, but can also solve complicated problems. This includes 
filtering out short individual audio disturbances. 

Spectral Cleaning in the "Remove" section can be useful for editing live 
recordings, where a single cough in the audience threatens to ruin an 
otherwise beautiful pianissimo effect. It can also be used to remove short 
distortions such as coughing, passing cars, a whistle, crackling or short drop 
outs. 

Spectral Cleaning can be applied directly onto the track per mouse click. 
Here, however, we will explain the functionality within the effect module, which 
offers more possibilities. 

Here's how it works: The clearly audible noise has a different acoustic 
signature than the rest of the material, otherwise it wouldn't be clearly audible. 
Based on this signature, the noise can be identified and filtered. After it has 
been identified, the audio material's frequency spectrum is analyzed before 
and after the disturbance. Based on this "acoustic environment", frequencies 
are calculated that can be used to fill the gap that was created after filtering 
out the disruptive signature. Ideally, a simulation of the "normal" background 
acoustics replaces the cough, almost as if it were removed magically. 

Let's roll: 

 First, set the play cursor roughly to the position of the distortion. 
 Open the Spectral Cleaning Editor. 
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 Try to select the distortion using the drawing tool in the editor. 
 Once you've selected the distortion, click on "Play". The algorithm becomes 

active immediately: The selected area is filtered out and replaced with 
frequency material from the surrounding "acoustic environment". 

 Can you hear an improvement? If not, change the selection. The selection 
should be as small as possible. Localize the audio disturbance by trial and 
error. 

 Once you are satisfied with the result, click on "Calculate". Up until now, you 
merely experimented, but now the settings will be applied. 

Tip: Spectral cleaning can be applies separately to either channel, for example 
when crackles can only be hears on one side of the stereo image. 

For information on the individual buttons in the editor, please read the entire 
documentation (available as PDF manual or program Help file). You can also 
access a tutorial video that explains the workflow directly from within the 
Spectral Cleaning Editor.  

The Spectral Cleaning Editor might seem a bit complicated, but it's a very 
effective tool that previously was reserved for pros. Therefore, it's worth 
investing some time to familiarize yourself with this tool. 

Cut out undesired passages 

Now let's take a look at some special kinds of audio disturbances. A typical 
example would be the noise of a microphone knocked against something by 
mistake or even any kind of crackling, crashing, rustling, which can't be 
removed satisfactorily with Spectral Cleaning, because it's too irregular. 

These kinds of noises as well as longer undesired passages can be cut out 
using the scissors tool in the left-hand corner of the track window.  
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 Select the scissor mouse mode.  

The mouse pointer turns into a pair of scissors. If you 
move it across the track, the playback marker moves 
with it. 

 Play the audio track and search for the section that you 
want to cut out. 

 Click before and after the section to cut at these points. 

This way, three separate objects are created on the track.  

 

 Switch back to standard mode, select the object in the middle and delete it 
by pressing the "Delete" key. 

 

A gap is created in the audio track. The problem is that where the disturbance 
used to be there is now absolute silence, which is irritating, too. It's not 
enough to simply cut out the audio disturbance, you have to add another 
sound into the gap, even if it's only a quiet hissing that is audible throughout 
the rest of the material, i.e. the room sound. Therefore, fill the gap with quiet 
material that features only hissing, for example. 

 Search for a suitable passage in a different section of the audio track that is 
roughly as long as the gap. Cut the audio track before and after the passage. 

 Switch back to standard mode and select the passage. Copy it to the 
clipboard (Ctrl + C or "Edit > Copy"). 
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 Set the position line to the beginning of the gap and insert the passage (Ctrl + 
V or "Edit > Insert"). 

 

 Move the bottom right handle on the inserted object to adjust its length to the 
gap (It will latch into the cut edges). 

 

That way, the distortion is "patched". All of the cuts can be fine tuned 
retroactively using the object handles to avoid crackling at the transitions. 

 

 There are handles at the top left and right hand corners, which allow you to 
create fade ins and outs. 

 The handle at the top center is for adjusting the volume. If you pull it 
downwards, the volume of the object is reduced. 

 The handles at the bottom left and right corners adjust the object's borders. 
You can fine tune your cuts by extending or contracting the object. 

Retouch short distortions such as cracks 

Let's take a look at a quick and elegant way of retouching short distortions 
such as cracks and clicks using a pen tool. 
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Note: You can't undo editing that you did with the "Draw wave shape" tool (no 
"Undo" function). After selecting the pen tool, you can decide whether, for 
safety purposes, you want to edit in a copy of the file or directly in the original 
material. 

 Search for a section in the material where you hear crackling and set the play 
cursor to that position. 

 Zoom into that section so that you can see the details of the waveform 
display. You can use the zoom button at the bottom right of the track 
window. 

 

 Take a close look. Can you see the crack? Look for a "mountain" that is flat 
on top or exceeds its surroundings. 
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 Select the "Draw wave shape" mode. 

The mouse pointer turns into a pen that you can use to draw 
directly into the waveform. If you click, the zoom level increases 
automatically and you can draw. 

It's about trying to turn the flat form a bit more into a peak and 
moving it slightly towards the bottom.  

This way, for example: 

 

The critical section should then look like this at the end: 

 

If you play back the material now, the cracks have disappeared. 
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Export 

After you have "cleaned up" the material, you can export your material: either 
song by song as MP3 or WAV file or all songs of the track as audio CD, DVD, 
or data disc. 

Switch to the "Export" workspace: Only the functions in the bottom left-hand 
corner of the screen are changed. 

 

If you haven't split each song on the track into a separate object, you will 
require track markers to specify the beginning of every new piece. With the 
help of the track marker assistant, you can control and change all track 
beginnings. If you need any help with burning CDs, use the CD assistant. 

 
To save the project click on the floppy disk icon. 
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Overview of the program interface 

 

 Import: Add new audio material here such as audio files from your hard 
disk, LPs or tapes via the record function, as well as songs from an audio 
CD. 

 Cleaning: You can remove audio disturbances in the track via the 
"Cleaning" screen. 

 Mastering: Use the "Mastering" screen to optimize the audio material in 
the track. 

 Export: Export audio material as an audio file and burn it directly onto CD 
or DVD via the "Export" screen. 

 Mouse modes: Select a suitable tool here: Arrow (Move mouse mode), 
Scissors (Cut mouse mode), "X" (Delete mouse mode), Clock 
(Resampling mouse mode), Pen 1 (Draw volume curve mode) or Pen 2 
(Draw wave shape) and Pen 3 (Draw spectral cleaning shape). 

 Menu bar: Here you'll find all functions of MAGIX Audio Cleaning Lab MX. 

 Overview track: View the complete project. The area which is currently 
being edited by the user is highlighted. 

 Track: Make detailed changes to the audio material here. 

 Object FX: Access the object effects for the selected song in the track 
here. 

 Transport control: Controls playback of the track. 

 Effects section: Here you can access the individual cleaning and 
mastering effects.  
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 Info Box/Analyzer: Switch between information on the currently selected 
function and the visualization screen here. The visualization screen 
displays the output signal graphically. You can choose between the 
following display options: peak meter, oscilloscope, phase correlator, 
spectroscope, and spectrogram.  

 Master volume: Set the total volume of the track here. The limiter hinders 
overmodulation, and the auto function enables the volume to be 
automatically optimized. 

 



 

Track window and constant control elements 33  

 

www.magix.com

Track window and constant control 
elements 

This chapter describes the display and control elements which are available to 
you independently from the selected section in MAGIX Audio Cleaning Lab MX 

Upper buttons 

The buttons located above the track display provide quick access to the most 
important program functions. 

 
Using this option you can set up a new MAGIX Audio Cleaning Lab MX 
project (view page 59). 

Keyboard shortcut:  E 

 
Using this option you can load previously saved projects (view page 
59).  

Keyboard shortcut:  O 

 
This button provides access to the most important save functions: You 
can either save -project (view page 59) or export the project as a wave 
or MP3 file. 

 
In the project you can undo the last changes you made. This way, it's 
no problem if you want to try out critical operations. If you don't like the 
result, you can always revert to the previous state using "Undo". 

Keyboard shortcut:  Ctrl + Z 

 
The “Redo” function undoes the previous “Undo” function. 

Keyboard shortcut:  Shift + Y 

 
Set a track marker at the actual playback position. 

 
Opens a menu with different functions to set track markers 
automatically. Additional information can be found via the CD/DVD 
menu (view page 143). 

 
Opens a menu with different functions to automatically recognize track 
names. By doing so the online database freeDB (view page 147) and 
mufin audioid (view page 149) functions are used. 
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MAGIX News Center 

The MAGIX News Center features links to current online tutorials and tips & 
tricks on the software application examples. The "News" is indicated by color 
according to content:  

 Green indicates practical tips & tricks for the software 
 Yellow reports the availability of new patches and updates 
 Red for special offers, contests and questionnaires 

If no new messages are present, the button will appear gray. When the MAGIX 
News Center is clicked, all of the available information will be displayed. Click 
the messages to reach the corresponding website. 

The master track 

Audio material display 

All of a project's audio material is displayed in the master track of the track 
window as a waveform. The waveform corresponds with the acoustic 
properties of the material. This means that there isn't anything to listen to at 
places where there isn't anything visually; higher waves mean high 
volumes. The tracks waveform display forms the most important basis for 
locating specific passages. 

The display is compressed, meaning that the waveform is displayed as a ratio 
of loud passages to quiet passages. This ensures correct display for quieter 
sections at the beginning or end of a song. 

Position line 

During playback a thin line will move horizontally from the left to the right over 
the master track. This is the position line, which indicate, which part of the 
wave form is currently reproduced.  

The last starting point of the playback is indicated by a small triangle in the 
master track. The position line will jump back to that position, once playback 
has finished. 

Timeline 

The timeline is located above the track. It shows the time position in the 
project. The measurement units can be selected from the "Options" menu. 
You can choose from: samples, milliseconds, hours/minutes/seconds, and CD 
frames. 
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The markers are also displayed in the timeline. They can be accessed, moved 
or deleted with the mouse. 

Navigation 

The task of the transport controls is to help you navigate through the audio 
material in the master track. Here you can find functions that you will already 
now from your old tape recorder. You can get more information in the chapter 
Transport controls (view page 40). 

The simplest solution, however, is to navigate directly in the track: a mouse 
click on the time ruler will set the starting point for the playback (even if 
playback is already running!) The space bar starts and stops playback. 

Overview track 

 

The overview track lets you select the project section which is displayed in the 
track display (displayed in blue). 

The tracks window now includes an additional overview track with a reduced 
display of the complete project. Now you can work at a certain position or on 
a certain song and keep an overview of the complete project and quickly 
navigate to areas that need work. In the overview track, you can also select 
the song or position in the material to be depicted in the track window. 

Move the section to the part of the project simply by clicking in the overview 
track; the zoom level remains the same. Define a new range in the overview 
track by clicking and dragging. Vertical yellow lines indicate the markers in the 
overview track.  

Use the "Overview mode" entry in the "Options" menu to show/hide the 
overview track. 

2 tracks 

 
Use the "2 tracks" button to create a second stereo track, for example, if 
you want to create transitions between two songs or to "park" a song on 
the additional track for the meantime. 
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An additional track provides a better overview when there are multiple objects 
in play. All objects can be moved randomly between the tracks. If moved 
between tracks while holding the "Shift" key, the horizontal position will be 
retained, i.e. only the track is changed. On the lower "shunting" track you can 
move the objects without moving the subsequent ones as well. Materials 
which are placed over one another will be played back simultaneously  and 
burned on CD. If this is desired, then the volume level at this position should 
be monitored, since objects which are playing back simultaneously add to the 
overall volume. 

Stereo 

 
If the stereo button is activated, the waveform display of the audio 
material for both stereo channels will be displayed separately. 

This view is useful to visually monitor processing of the material in the stereo 
panorama, or to locate precise crossover points during editing operations. 

Surround 

 
Opens the Surround editor. 

Read more on this topic in the "Additional sound effects (view page 103)" 
chapter! 

Volume curve 

 
You can activate a volume curve (view page 64) with the Volume curve 
button. 

Spectral display 

 
In addition to the waveform display, this button allows a spectral display 
of the audio material to be shown as well. 

Spectral display equates the X axis (horizontal) to the time dimension. In 
contrast to the waveform display, whereby the height of the waveform only 
indicates the total level of the signal, the spectral display shows the level of 
each of the audio signal's individual frequencies. The actual level of each 
frequency is indicated by the color of the points in the spectrogram image.  
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The whole color spectrum is used to display the volume of individuals 
frequencies. Pink indicates loud sounds in a frequency range, green indicates 
the areas with middle volume and red the very quiet sounds (in the default 
color scheme). Black is used for quietness and white for maximum volume. 

Different color palettes can be selected in the menu "Options -> Spectral 
display". "Display values scale" in the same menu ("#" key) shows an object's 
frequency scale. 

Spectral cleaning is significantly more processor-heavy than the normal 
waveform display, so redrawing after a section changes is always slightly 
delayed. This delay is increased the further the zoom is extended, since 
MAGIX Audio Cleaning Lab MX needs to include more and more data for 
calculation of the display. For this reason, spectral display is only available 
from a certain zoom level. 

Spectral display of the audio enables specific disturbances in the audio to be 
detected. Clicking can be recognized by vertical lines across the entire 
frequency spectrum; continuous disturbing sounds can be detected by 
horizontal lines.  

More detailed explanations can be referenced in the section "Spectral cleaning 
(view page 81)". 

This display also makes it easier to find sections in a song quickly, since 
instrumental changes can be clearly seen in the spectrum. On the other hand, 
the waveform display will not indicate changes if the volume level does not 
fluctuate. 

Mouse mode 

"Mouse modes" are your tools when working in the track window of 
MAGIX Audio Cleaning Lab MX. Depending on which mode you 
choose, the mouse pointer will look differently and have a different 
function in the track window. 

The following modes are available: scissors (for cutting), magnifying 
glass (for zooming), eraser (for deleting), arrow pointer (for standard 
operations), a clock (for changing playback speed) and two pens (for 
drawing a volume curve or a waveform). 
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Move mouse mode 

 
The shift mode is preset. It allows you to handle all-important tasks:  

Select objects in the track window with a left-click. Selected objects can be 
moved or deleted in move mode. All subsequent objects are also moved so 
that no unwanted gaps develop later in the track. The object can be removed 
from the track with the Del key. All subsequent objects are moved so that no 
gaps occur.  

In move mode you can use the 5 handles to fade or shorten all objects or to 
change the master volume. 

Right-clicking on an object opens the so-called context menu from which you 
can select important editing options for the object. 

Keyboard shortcut:   V 

Cut Mouse mode 

 
The cutting mode converts the mouse pointer into scissors. Every 
object can be cut on the mouse position.   

This creates two separate objects that can be edited separately.  

Moving the mouse over the wave form depiction of the audio material you 
move the Position Bar along with the mouse pointer. So you can control 
exactly the point where you want to cut. The perform precision editing we 
recommend zooming the wave shape display before using the cut mode. 

Like in move mode, right-clicking on an object opens the so-called context 
menu from which you can select important editing options for the object. 

This mode is suitable for dividing a recording into different parts in order to 
apply object effects to each of the passages.  

Keyboard shortcut:  H 

Delete Mouse mode 

  

The "Delete Objects" mode turns the mouse pointer into an eraser. In 
this mode you can delete objects from the project. 

Following projects are drifted automatically with the Track Markers in the 
position of the deleted object. 
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In Move mode you can also mark an object and press the Del key on the 
keyboard to delete it.  

Keyboard shortcut:  O 

Resampling/Timestretch mouse mode 

 
This mode lets you change the playback speed of objects with the 
mouse so that they are better aligned. 

You can use this mouse mode by stretching or squashing the object at the 
rear object handle below. The mouse cursor turns into a clock. 

Resampling mode (preset) can be used to change speed and pitch just like on 
a tape, i.e. speed and pitch are changed together as one. If an object is 
compressed with the mouse, the speed and pitch increase just like a tape 
when it is played faster. 

In the timestretch mode, the pitch remains unchanged, if the object length and 
with it the speed are changed. 

You can switch modes by opening the Object FX page (view page 64) of an 
object, switching to the cleaning effects, and then selecting timestretching 
from the tempo/resampling effects presets list. 

Draw volume curve mouse mode 

 
With the Draw volume curve mode you can "draw" any volume curve 
using the mouse. 

This way, you can create irregular volume progressions quickly. 

To delete volume curve points, double-click on the corresponding point or 
click on a point in the erase object mode (view page 38). You can delete 
multiple points by holding the Shift key and clicking the first and last points so 
that all points in between are selected.  

Selected volume points have a blue frame. You can now delete the points with 
the Delete key. 

Wave drawing mode 

 
Repair short distortions such as crackling directly in the wave form of 
the audio file by using the Wave drawing mode. Such distortions 
usually only last a few sample values, so you can use the mouse and 
try to draw along the original waveform without the distortion.  

There is an automatic zoom function in the wave form display when you 
switch into the Wave drawing mode, so sample values become visible.  
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Warning: Unlike other editing of the master track which only affects the 
project, this mode lets you work directly with the Wave audio file, i.e. on the 
recorded raw material, which is changed directly and permanently. Create a 
backup copy to undo changes. Back up copies are created automatically 
when working with MP3 and other compressed formats, since such files have 
to be converted into the Wave format for this function. 

Spectral edit mouse mode 

 
You can remove individual noises within the sound spectrum of the 
audio material with the help of the spectral edit mouse mode. 

In that case, it is a simplified version of Spectral Cleaning (view page 81) that 
is integrated into the master track. 

The view of the master track changes to Spectral display (view page 36) and 
you can create an area around the noise with your mouse.  Its size is still 
adjustable afterwards by simply stretching the handles at the frame.  

 

You can hear the impact of the effect straight after playing the corresponding 
passage. Two buttons are located at the frame of the disturbances. By 
clicking "OK" the editing will be calculated into the audio material instantly. A 
copy of your original material has been automatically saved beforehand so you 
can undo any editing (Strg + Z).  

By clicking "Cancel" you delete the frame and end the filtering process. 
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Transport control 

Use the transport control to control the playback position in the project. The 
position line, which indicates the current playback position, is a thin vertical 
line located in the track window. 

 

Quickly move the position line within the project by using the position slider.  

The time display indicates the current playback position (using 
the measurement unit selected via Options > Measurement units 
(view page 154)) 

 

Use the transport control to start and stop playback, move forward and 
backward within the project and set the position line back to the very 
beginning. 

 

Loop: Clicking on the loop button starts playback an endless loop. 
This function is useful if you wish to monitor transitions or effect 
settings in critical sections and therefore want to listen to certain 
ranges or objects repeatedly. You can extend or shorten the loop 
range in the Timeline by using the mouse or by entering changes 
numerically in the "Playback parameters" window (options menu). 

 

Return to start: Resets the position line to the start of the project (also 
works during playback). 

 

Rewind/Fast-forward: Rewind/fast-forward first starts slowly, then 
quickly speeds up if you continue to hold the rewind or FF button. This 
corresponds to the functionality of a tape recorder which also takes 
some time to gain speed. 
Alt + Click on this button lets you jump to the next or previous marker. 

 

Stop: Stops playback, the position line jumps back to the starting 
position. 

 

Play: Starts playback, clicking again stops playback at the current 
position. 

 

Recording: Opens the record dialog where you can set the recording 
format, level etc. The actual recording is started in the record dialog. 
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Control functions of the keyboard and mouse: 

 The space bar starts or stops playback.  
 A simple mouse-click in the timeline above the track moves the position line 

to the corresponding position (also works during playback). 
 The Pos 1 key moves the position bar back to the start of the project. 
 Use the position slider to quickly move the playback cursor within the project.  
 Other special keyboard commands are available to jump between markers 

and object borders quickly, see Zoom commands (view page 43). 

Analyzer 

Audio material being played is graphically illustrated in the visualizer. You can 
choose between the following display options: Peak Meter, Oscilloscope, 
Phase Correlation, Spectroscope and Spectrogram. 

 

The visualizer can be modified to your taste. To do this click on Setup, a 
context menu will then open in which you can select the display mode. There 
are numerous presets for every display mode under "Presets". 

Info Box 

The Info Box offers fast and immediate help when 
working with MAGIX Audio Cleaning Lab MX. 

Please click on an effect to receive information on 
purpose of use, functionality, correct handling and 
possible sources of error. 

With the help of sound examples, you can listen to 
the result of the effect. "Before" plays the effect 
previously to the application and "After" the result 
with the applied effect. 
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Clicking on an object displays the applied Object effects (view page 72), if 
available. The Info Box also offers useful tips for other program areas. 

Zoom 

The waveform display allows you to recognize certain parts of the material 
from the shape. For many tasks it is quite useful to enlarge the waveform 
display. For detailed editing, e.g. editing with the scissor tool, there are several 
zoom options: 

Quick zoom: For quick zooming it is sufficient to click with the mouse in the 
timeline, keep the mouse button pressed down and move it up or down. This 
way, you can quickly zoom the cursor in and out at any position without 
releasing the mouse. 

  
The +/- zoom button at the bottom right corner of the track 
window zoom in/out the display. 

This enlarges the central area of the track window. Clicking on the adjacent 
triangle opens the zoom menu. Here you can open different zoom and 
navigation commands (view page 43). 

By selecting an area in the overview track (view page 35), you can also 
determine the visible section of the project. The overview track is located 
above the track window and displays the entire project irrespective of the 
selected zoom level. 

 You can click on this symbol or the "a" key to quickly restore the fullscreen 
view of the project. 

 

Moving the scroll bar forward and backward allows you to quickly navigate 
through the project. Dragging the scroll bar ends adjusts the size, which also 
zooms in and out of the project. 
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Zoom settings 

Command Keyboard shortcut Description 

Play/Position marker  Commands for quickly 
editing the playback position 

Marker left Alt + right 

Marker right Alt + left 

The play marker can be 
moved quickly between the 
markers. 

Object border left Shift + Alt + right 
Object edge right Shift + Alt + left 

The play marker can be 
quickly moved from object 
edge (object start and end) to 
object edge. 

Zoom ranges   

Show all A The entire project is visible. 
Zoom 1s 1 
Zoom 10 s 0 
Zoom 60 s 6 
Zoom 4 min 4 
Zoom 10 min Shift + 0 

The visible section of the 
project is quickly set to the 
selected value. 

Vertical zoom  

Zoom into waveform Ctrl + Cursor down 
Zoom out of waveform Ctrl + Cursor up 

Vertically zooms in and out of 
the wave shape. This is useful 
for locating the crossover 
point (for precise sample 
editing). 

 

Volume controller/auto button 

This controller sets the playback level of the track. Before exporting, the 
project should be set as loud as possible in order to receive an optimally 
calibrated recording level. The "Auto" button below the volume control is for 
automatically optimizing the volume (normalizing).  

In order to set the volume of the project as high as possible, place the position 
line just before the loudest part of the project and start playback (the loudest 
position can be found by locating the highest peak of the wave shape display). 

After you have played the loudest part, click on the "Auto" button below the 
master volume control. MAGIX Audio Cleaning Lab MX automatically adjusts 
the volume so that the loudest part of the range that was just played is exactly 
0 dB,  i.e. the maximum volume. 
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Note: The volume controller adjusts the volume of the project, i.e. the volume 
that is finally used for exporting. If you want to set the level lower here (e.g. 
because you are talking to someone), the project will also be exported quieter. 
It is better to adjust the monitor volume with the sound card mixer or directly 
on your stereo system (e.g. monitor speakers) and to leave the volume control 
at the position recommended by the "Auto" button. 

To adjust the monitor volume in the sound card mixer, you can click on the 
loudspeaker symbol in the tray (at the right bottom corner of the screen). 
However, you can also adjust it directly in the "Playback parameters" (view 
page 153) dialog. 

LED Display 

The LED display is a peakmeter and shows you the maximum peaks during 
the playback of the audio material on the track. In the stereo tracks, the left 
LED-chain will indicate the level of the left channel and the right LED-chain the 
level of the right channel. Both chains will show the same values while working 
with mono tracks.  

Bypass FX 

Switch all effects on or off with this button to directly compare the original with 
the processed audio. 

Limiter 

 The limiter can be switched on to reduce clipping. This device works 
sound-neutrally and provides a final guard against extreme levels. 

 

Status line 

On the lower edge you will see a display of the remaining capacity (depending 
on the storage medium selected for export), and the current system 
resources. 

Used space indicator: 

The storage medium display compares the allocation of the master track to 
the capacity of a defined output medium, for example, of an audio CD or of a 
data DVD. 

 

By clicking on this symbol you can adjust the 
storage medium display of different output media 
such as CDs, audio/video or data DVDs (MP3s). 
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System display 

 

The system resources are very important while writing a CD in real time. Once 
the process has been started, it cannot be interrupted. When writing "on the 
fly", the computer has to calculate the playback including all real time 
functions and write them on the CD at the same time. If the system is not fast 
enough, the process will be aborted and the CD will be useless. 

The system display of the MAGIX Audio Cleaning Lab 11 helps you to prevent 
such problems when writing a CD. 

If your system is overcharged, activate the "Create an Image file" option in the 
"Make CD" dialogue. This will create a stereo file, which will be the source for 
the writing process. This file includes all effects and object settings, as well as 
the tracks and track markers, so that the system doesn't need to calculate 
them again while writing various copies (see Write CD parameters (view page 
114)). 
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Import 

 

Audio files 

MAGIX Audio Cleaning Lab MX can import audio files in 
the formats WAVE, QuickTime (*.aif), Ogg Vorbis (*.ogg), 
MP3, WMA, FLAC, and AVI (soundtrack only). 
To do this, click the corresponding button "Audio files" in 
the import section and the "Load audio file" dialog will 
open. 

Select any folder containing audio files. Every file listed can be previewed and 
loaded into MAGIX Audio Cleaning Lab MX. The selected file is attached to the 
last object following a pause of 2 seconds. 

You can also load several files simultaneously. Just as in Windows Explorer, 
you can extend your selection with "Ctrl" + click, or select a series of files with 
"Shift" + click. 

The pause inserted between the files (2 seconds by default) can be changed 
in the CD/DVD menu with Automatic pause settings (view page 144). If you 
have tracks which blend over one another and which are distributed on 
several files then you should change this value to "0".  

Keyboard shortcut:  W 

Record 

The "Record" button opens the audio record dialog. 
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Basic knowledge about recording with the PC 

The record function converts analog audio signals – records, tapes, sounds, 
speech – into digital data, which can be saved on the PC and edited with 
MAGIX Audio Cleaning Lab MX.  

The device which is used to digitalize the audio signals is already built into 
most sound cards and aptly called an analog-digital converter, often 
abbreviated with A-to-D, ATD or A/D. In order to record sounds, the A/D 
converter takes samples of the sound to be digitalized at fixed intervals by 
measuring the voltage level of the signal. The frequency of the sampling is 
called the sample rate and naturally lies within the kHz frequency range; 
several thousand times per second. The higher the sample rate, the more 
samples are recorded by the A/D converter, thus making the sound 
conversion closer to the original.  

The precision with which the A/D converter measures the voltage level of the 
analog signal is determined by the sample resolution. The same principle 
applies here: The finer the resolution, the better and more natural the digital 
conversion.  

Audio recordings in CD quality are recorded with a sample rate of 44.1 kHz 
and a resolution of 16 bits. 

Connecting the source for recording 

First of all, the source of the audio material must be connected to the sound 
card input. Again, there are several possibilities which primarily depend on the 
type of equipment you have. 

If you are recording from a microphone, then please connect the microphone 
to the microphone jack on your sound card (usually red). 

If you want to record material from a stereo system, then you can use the 
line-out or AUX out jacks on the back of your amplifier or tape deck. This 
involves connecting them to the sound card input (usually red).  

If your amplifier has no separate output (other than for the speakers), then you 
can use the connection intended for headphones for your recordings. In most 
cases, you will need a cable with two mini-stereo jacks. This type of 
connection has the advantage of being able to set the headphone input signal 
level with a separate volume. As headphone connections generally are not the 
best, it is advised that you use the line outputs if possible. 

When recording cassettes from a tape deck, you can connect the tape deck's 
line out directly to the sound card input. 

When recording from vinyl records, you should not connect the record 
player's output directly with the sound card because the phono signal needs 
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to be pre-amplified. A more suitable method would be to use the headphone 
connection or an external pre-amp. 

Record dialog 

The "Record" button in MAGIX Audio Cleaning Lab MX opens the record 
dialog. However, the recording source must be connected to the input of the 
sound card with a suitable cable first. For more information, please read the 
"Recording basics" (view page 48) chapter. 

 

Audio input: Opens the input and level automation (view page 52) for 
automatic selection of the correct input signal and level. 

Recording level: Displays whether the level of the signal you want to digitize is 
correct. To set the level, play the loudest part of the material you want to 
record and monitor the display. Like with analog recordings, the sound of 
digital recordings has to be optimized as well. Too low level settings will have 
adverse effects on sound quality, distortions lead to unpleasant "clippings". 

Recording: This button starts the actual recording. During recording, 
recording time and remaining space on your hard disk are indicated. Monitor 
the recording level on the LED display. If the display reaches the upper LEDs, 
there was a distortion at some point. In this case, you should definitely check 
the recording for clippings and, if necessary, repeat the recording using a 
lower recording level. At the end of the recording  you will be asked if you 
want to use the recording. The newly-recorded material will be placed at the 
current position of the playback marker in the arrangement.  

Recording pause: Pauses the recording. Click the button again to resume. 

Stop: This button ends recording. The recorded material is then inserted into 
the upper track as an object. If objects are already in the track, the recording 
is attached to the last object after a pause of 2 seconds. 
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Advanced…: Opens the Advanced view of the record dialog (view page 50) 
with access to additional settings options.  

Help: Opens the program's help file for the record dialog. 

Close: Closes the record dialog. 

Keyboard shortcut:  R 

Advanced settings in the recording dialog 

 

Automatic recording stop: If this button is activated, recording will cease 
automatically after approx. 16 seconds of silence. This means that you can 
record without having to stop the process manually when the recording 
source ends. 

Automatic CD track recognition: If this button is activated, then track markers 
are automatically placed at the end of the pauses after a track. In order for 
pause recognition to function seamlessly, you will have to set the proper 
source in the selection box (LP, cassette, CD, or Internet). You can specify the 
detection parameters even further in the Options menu via >Automatic track 
marker recognition options (view page 155). 

Save automatically in individual files: If this feature is active, then every 
individual track that is recognized will be saved as a unique file. 
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Set CD track marker: Even during recording, you can set track markers by 
clicking the corresponding button in the recording dialog. 

Start new file: If you want to record for very long sessions or multiple sources 
one after the other, then the recording file can become extremely large. This 
button will create a new sequentially numbered file each time it is pressed. 

Recording format: This setting determines the sampling rate and bit resolution 
(deluxe version only) of the recorded audio file, and also whether the recording 
should take place in stereo or mono. 

24-bit recording requires a high-quality audio card with 20 or 24-bit 
conversion, plus a 24-bit capable MME driver. Audio cards with SPDIF digital 
interfaces can also record audio material in 24-bit quality. 

You can also record directly in compressed formats such as MP3 or OGG 
Vorbis. Select the format you want to use from the list box, and use "Format 
options" to specify details such as the bit rate and compression method. 

Double Speed Recording: Activates the Recording at double speed (view 
page 51). 

Audio input: The button "Sound card settings" opens a dialog with special 
settings (view page 55) for whatever sound card is present. The name of the 
selected sound card is also displayed. If you are using several sound cards (or 
such with several inputs), then you can select one from the menu.  

Timer: Enter a starting time for a recording and the length of the recording. 
The recording doesn't begin immediately after pressing the "Record" button, 
but rather at a specifically set time. This way, time-delayed recordings (for 
example, at night or when you're out) are now possible. Of course, the system 
clock has to be set correctly. If "Record length" is also activated, then the 
recording will end automatically after the indicated period. 

File name/file path: The name of the audio file to be created and the preset 
folder are displayed in the recording window. Both can be changed by clicking 
the folder button. 

Shut down computer automatically after recording: If you are working with 
timer recordings, you might as well have the computer shut down 
automatically after the recording is complete. 

Simplified...: Simplified version of the recording dialog. 

Double speed recording 

Some double cassette decks have a "Double Speed" copy function. On one 
deck a cassette will be played at double speed and on the other recorded at 
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double speed. Doubling the speed cancels itself out so you will end up with a 
completely normal cassette recording. Thereby making it possible to copy 
cassettes in half the time.  

With the option "Double Speed Recording" you can also use this function 
with MAGIX Audio Cleaning Lab MX. If it's activated you can record played 
audio material at double speed, after recording the speed of the recorded 
material will be automatically halved.  

Input and level automation 

Every sound card has a least two inputs (microphone and line), as well as 
various "internal" inputs for the CD drive or the signal from another program, 
for example, Internet radio. With input and level automation you can 
automatically select the correct input for your recording without having to 
search and adjust the input level in order to avoid distortions. 

To do so, click on "Audio input" in the record dialog. If you had already 
connected your source and begun playback, the correct input will be 
determined immediately. Otherwise do this now and click on "Search channel 
again". 

If this didn't work, use the "Windows mixer" button to open the Windows 
Mixer and select the channel manually. 

Adjusting the recording level is essential when recording digitally via sound 
cards in order to achieve optimum sound quality. If the adjustment is set too 
high, distortion occurs and the incoming signal must be reduced. If you 
reduce input sensitivity, the resolution at which the analog signal is digitized is 
also reduced. The level controllers of your sound card should generally be set 
as high as possible in order to achieve optimum results. Yardstick for an 
optimal level is the loudest part of the material. The loudest part should be 
adjusted to the maximum. You can now adjust the recording level with the 
help of the LED display in the record dialog. 

You can adjust the level of the source manually using the "Volume" controller. 
If you activated "Automatic level adjustment", the level controller will 
automatically be set to the correct value.  

Monitor while recording 

Do you want to listen to your digitizer while you are recording? It may not work 
from the start for the following reason: 

Most sound cards, including the ones integrated in a PC ("onboard sound") 
offer help for the Windows sound card mixer. You can change the different 
input and output levels of the sound card or choose a digitizer. 
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You will also find a signal route within the mixer. This route passes an input 
signal through to the output of the sound card. The corresponding volume 
controls within the mixer are called line -In, microphone or stereo mix. 

The functions, as well as the descriptions of the input and output controller 
within the Windows mixer, may differ depending on the sound card and sound 
card driver. Windows mixer is only a standardized "interface" for the sound 
card driver. 

Regardless of MAGIX Audio Cleaning Lab MX, Windows and the sound card 
driver enable you to listen while you record. 

 

Recording: Sound card with Windows mixer support 

Many sound cards or audio devices, such as USB record players offer either 
an incomplete or no mixing support at all. In that case, you don't have the 
option of monitoring while recording. If you go to "sound cards properties 
(view page 55)" within the advanced recording dialog you will find the option 
"Listen to the sound during the recording". If you activate this, MAGIX Audio 
Cleaning Lab MX will conduct the input signal to the output. 

 

Recording: sound card without Windows mixing support 

24 bit audio support 

Audio files in MAGIX Audio Cleaning Lab MX can not only be recorded in 16 
bit quality, but also in far superior 24 bit resolution. Simply select the "24 bit" 
option under "Resolution". 24 bit recordings require a high quality audiocard 
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with 20 or 24 bit converters, as well as a 24 bit-compatible NME drive. 24 bit 
audio material can also be transmitted via audiocards with SPDIF digital 
interfaces. 

We have had positive experiences with the 24 bit audiocards produced by 
Marian, RME, SEKD and Terratec. 

The high resolution audio files are stored and edited in the 32 bit "floating 
point" file format by MAGIX Audio Cleaning Lab MX. This ensures the full 24 
bit quality independent of the gauge. The dynamics may increase to over 140 
dB, while the recording’s jamming transmission sinks, according to the type of 
audiocard, to 110 dB and more. Thanks to floating point processing, there is 
no need to worry about internal editing being distorted. Floating point 
processing only starts to distort at around 1,500 dB above zero – in contrast 
to a 16 bit signal that distorts immediately once the zero dB line has been 
traversed. 

Even in cases whereby audio material is intended for burning onto a 16 bit 
CD, it is worth selecting 24 bit recording because all effects calculations are 
made in a higher quality and therefore no "rounding" mistakes can be 
detected in the audible 16 bit range. 

24 bit recordings (via storage as 32 bit float files) take up twice as much 
storage space on the harddisk as 16 bit recordings. But with current harddisk 
storage capacities, it works out as a good compromise when one considers 
the increase in quality. 

High resolution audio files can be imported and exported as 24 bit WAV files, 
enabling trouble-free file exchange with other high quality audio systems, such 
as MAGIX Samplitude. 

Digital transfer 

With the recording function, digital audio data can be transferred to the hard 
drive through a digital interface (e.g. S/PDIF or ADAT). 

ADAT or DAT recorders normally produce data with a sampling rate of 48 kHz. 
For a CD project with 44.1 kHz you must convert the sampling rate. This is 
carried out in real time by MAGIX Audio Cleaning Lab MX. The digital signal is 
read at 48 kHz, but is automatically converted and inserted into the project as 
an audio file at 44.1 kHz. 

For this to occur correctly, you must first set the sample rate of the incoming 
signal in the recording dialog. Click on the "Dev." button in the recording 
dialog. In the following dialog (sound card characteristics), set the audio 
recording formats supported by the sound card. 
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Now, connect the digital output of your recorder to the digital input of your 
sound card, and now start recording! 

Record properties 

This dialog provides you with information regarding the currently selected 
sound card. Supported audio formats of the sound card and the sound card 
driver's information is also displayed. 

Driver system: Here you can switch between driver types (MME and WDM).  

Note: Adjust this setting only if you have problems with audio playback or 
recording. 

Special: Some sound cards or audio devices (for example, USB turntables) do 
not offer mixer support. With the "Monitor input signal" option you can listen to 
the sound during recording (monitoring).  

"Filter DC offset" allows you to remove the DC offset section (view page 80) of 
the input signal, even during recording. 

CDs 

With CDsyou can import music from a CD into the 
program. 

 

Import CD 

You can import entire Audio CDs or individual CD tracks into the project. 
Unlike data CDs, audio CDs require special treatment while importing 
("grabbing" or "ripping"). The data is imported digitally, thus eliminating loss in 
sound quality.  

To import audio tracks you should proceed as follows: 

1. Insert an audio CD into the drive and click on "Import CD". A dialog with a 
list of the CD tracks will open. If you have more than one drive, you may 
have to first select the drive containing the CD. You can do this in CD drive 
options. 

2. Select the desired tracks (multiple selection by Ctrl + mouse-click). 
3. Click on "Copy selected track(s)." 
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4. The "Import project" dialog will now appear. Here you can enter the file 
name and select the target directory.  

5. The audio material is then copied from the drive onto the hard disk. A 
progress bar is displayed. 

Once ripping is complete, the dialogs will be closed and the tracks are 
inserted into the project as individual objects. 

Keyboard shortcut:  D 

The track list dialog 

  

Copy selected track(s): This button starts audio copy. A new object is created 
for every track in the arrangement and the corresponding track marker is 
created. 

Transport control: This lets you start 
and stop playback just like on a real 
CD player and skip forward and 
backward in the playlist. 

Details on the total length and the memory capacity of the selected track are 
displayed below.   

Select all tracks: All tracks are selected, for instance, to copy the entire CD. 
Several subsequent tracks can also be selected by holding the "Shift" key and 
left-clicking; "Ctrl + mouse-click" selects several tracks. 
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Get CD Info (freeDB): Request title information from the  freeDB Online CD 
database (view page 147)  

In the right selection box you can select the read speed, and in the left one 
you can select the export mode (see Configuring the CD-ROM (view page 
58)). 

CD drive options: Here you can change the settings and select the drive for 
importing the CD if you have installed several CD drives (see also CD-ROM 
drive dialog).  

Write text file: Title list including the exact names and times can be exported 
as a text file for archiving purposes. 

Dialog: Load audio file 

The "Import project" dialog appears after you have selected the option "Copy 
selected tracks". Here you can specify name and target address of the audio 
files. The audio files are subsequently numbered depending on their names 
(name -> name_1.wav, name_1.wav...). 

Audio tracks (CDA files) are imported as WAV files by default. However, they 
can already be converted into MP3s during import. To do this, select the 
corresponding audio format in "file type" of the dialog "Import project" and 
then make the corresponding "format settings" (for more info on the audio 
formats please also read "Loading audio").  

Copy-protected audio CDs 

According to the copyright act it is forbidden to copy a CD with copy 
protection, but the owner of a CD may create a backup copy.   The problem 
with copy-protected CDs is that they cannot be imported using conventional 
PC drives. In order to create a backup of such a copy-protected CD you have 
to play it on an audio CD player and record it as a regular analog recording via 
the sound card. 

Drive list dialog 

You can select and configure the disc drive if you have more than one drive.  

Configuration: This button opens the configuration dialog  (view page 
58)where you can make various special settings, SCSI IDs, etc. 

Reset: Restores the default settings of the drive. 

Add drive: Creates a new drive letter in the list which still requires special 
settings. 

Delete: Deletes the selected drive. 
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Save setup: Saves the current drive list and all configuration data in a *.cfg 
file. 

Load setup: Loads the current drive list and all configuration data from a *.cfg 
file. 

The CD-ROM configuration dialog 

Drive name: Lets you edit the name of the drive in the list. This is useful if you 
create more than one entry accessing the same physical drive.  

Host adapter number: Lets you specify the number of your SCSI adapter - 
normally "0". 

SCSI-ID: Lets you set the ID of your CD-ROM drive. Be sure to set the correct 
ID; there is no error checking! 

SCSI-LUN: Select the SCSI-LUN parameter, normally "0". 

Alias: Lets you select the manufacturer type of your CD-ROM drive. 

Normal copy mode: Copies the audio data without any software correction. 

Sector synchronization copy mode: Copies the audio data using a correction 
algorithm. This is especially useful, since many CD drives have problems 
finding an exact position again and gaps can occur. 

Burst copy mode: Optimizes the speed of the copy process; no software 
corrections made.  

Sectors per cycle: Defines the number of audio sectors that should be read 
from the audio CD in a read cycle. The higher the number of sectors, the 
faster the copying process. Many SCSI systems have problems with more 
than 27 sectors. 

Sync sectors: Sets the number of audio sectors that will be used for software 
correction. A higher number results in a better synchronization but also in a 
slower copying process. 

Copy-protected Audio CDs 

It is forbidden to copy an Audio CD, whether it is with or without copy 
protection. Each owner of a CD may however produce a backup copy of 
copy-protected CDs. The problem is that one cannot create a copy from 
copy-protected CDs since the CD cannot be read in with a conventional PC 
disc drive. In order to create a backup copy of a copy-protected CD, you 
must play it in an Audio CD Player and record it as a "normal" analog 
recording via the soundcard.  
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Editing in the track view 

What is an object? 

Objects provide you with a wave form-interpretation of your audio material. 
The starting point of each object is related to one single point in the audio file. 
The length of the object determines the length of the excerpt from the audio 
recording. So, an object does not represent the audio material itself, it is just a 
replay command. While editing objects you just define additional commands 
which will be executed in real time each time you listen to the object. For this 
reason, the original audio material never gets altered and nevertheless your 
personalized settings are permanently saved. This kind of data treatment is 
known as "non destructive-editing". 

As objects are merely replay commands and they only indicate which audio 
material has to be played, you can move them to any desired position within 
the track window or even delete them without changing the content of your 
audio file. 

Objects are important for differentiated sound editing of single tracks or loops.  

Objects are subdivisions of your audio material which can be edited 
separately. Tracks are in contrast simple markers for an audio CD.  

Objects can be cut into an arbitrary number of smaller objects, and they can 
be moved to the master track or even deleted.  

Should you move or delete an object in the track, all objects that appear after 
the deleted object will move up one position including their track markers, so 
that the pause between the songs will be preserved. 

You do not have to move the objects themselves to change the sequence of 
the songs. As the following objects will all move up one position, this would 
only be possible using a second track. It is much easier to move the 
corresponding track markers in front of or behind another track marker. Doing 
this will regroup the corresponding objects. The most comfortable solution is 
to use the arrow keys in the CD track list. 

Project 

The project (*.vip file) contains all data MAGIX Audio Cleaning Lab MX uses. It 
does not contain audio data but only the names of the imported and recorded 
audio data and the saved locations on the hard drive, all edits, reductions and 
most effects processing. Furthermore, the object display on the tracks is 
referred to as a project. 
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Adjust object volume 

 

The handle at the top center can be used to adjust the volume of the objects. 
This handle is particularly important for synchronizing the volume of songs 
originating from different sources. The volume of audio CDs may also differ. 

Fading objects in and out 

 

At the top corners of every object there are two fade handles that can be 
adjusted to fade an object in or out. It is particularly useful to use the fade 
handles when you have cut passages out of a recording to avoid hard 
transitions or crackling. 

Duplicate objects 

Objects may be duplicated very easily. Click on the object to be copied with 
the mouse while holding down the "Ctrl" key. This generates a copy, which 
you can immediately drag to the desired position or cut separately. 
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Reducing and increasing the length of objects 

 

All objects can be shortened by moving the mouse to the right corner of the 
object until the mouse pointer turns into a double arrow symbol. You can now 
reduce the size of the object. This way the songs or recordings are shortened 
without having to be edited. 

Drag the handle to the right to make the object longer again. If you can't move 
the object borders further, it means that no audio material is available. 

If a few seconds silence were accidentally recorded at the beginning, you can 
easily remove them by moving the left handle. If too much audio material was 
removed, you can restore it by moving the object border back in the other 
direction.  

Deleting and moving objects 

Every object can be removed from the the track with the "Eraser" tool (or the 
Del key). No gap will be created in the project, i.e. the subsequent objects are 
moved. 

All subsequent objects will be moved along in unison automatically so that no 
gaps appear. 

Cut objects 

Use the commands "Remove object beginning" or "Remove object end" (keys 
D and U) in the "Edit" menu to remove superfluous beginnings and ends of a 
recording.  



 

 62 Editing in the track view  

www.magix.com

To do so, set the object's position line to the beginning of the part of the 
object you want to keep (i.a. the music) and press D.  Now, set the position 
line to the end and press U. 

Alternatively, you can use the scissors mouse mode. Use it to click on the 
parts of the wave shape where you want to split the recording. No longer 
required objects can now be removed from the track with the Delete tool or 
Del key. 

If you cut objects, a short fade is created automatically at the cut position to 
prevent crackling. 

If you separate the material into small objects, you can rearrange the order 
entirely. For such arrangements we recommend using the second track (view 
page 152), which can be used for shifting the objects. 

To find the best parts for object cuts, we recommend working with an 
enlarged view of the wave shape display. The magnifying glass is an ideal tool 
for such purposes. Left-click into the wave shape display with the magnifying 
glass tool to enlarge it, right-click to reduce the size again. 

Join and mix objects 

When you push an object from the right over the object to its left, it will cover 
it like one sheet of paper covers another (completely or just in part). The 
invisible part of an object will not be played.  

The program automatically inserts a crossfade between the two joined objects 
if the fader-handle of the second object is dragged a bit to the right. This is 
another method to remove clicks. 

 
A fade in a selected objected is represented by a Crossfade symbol.  

The shape of the crossfade curve can be changed by clicking on this symbol. 
You can also apply the Surround Transitions here. 

You can make the invisible part of the second object visible (and audible) 
again just by moving the second object to the right.  

You can do the same using the second track. Passages that are overlapping 
on two tracks will be played as overlapping. Now you can search for your ideal 
mix using the volume and the length handle, cutting your object and moving it. 
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Fading objects 

With every cut the two objects that are created are slightly crossfaded in order 
to avoid crackling. This is called Auto crossfade. A crossfade is also added if 
two objects in a track are moved into each other or overlap each other. 

 
A crossfade symbol is added to each crossfade. By clicking on the 
symbol, you can change the curve of the transition. 

The top handle of the right object allows you to regulate the fading in and out 
of both objects.  

 

The bottom handle controls the length of the two objects. If you move them, 
one of them is extended whereas the other is shortened. The length of both 
objects together remains the same. 

Change song order 

You do not have to move the objects themselves to change the sequence of 
the songs. As the following objects will all move up one position, this would 
only be possible using a second track. It is much easier to move the 
corresponding track markers in front of or behind another track marker. Doing 
this will regroup the corresponding objects. The most comfortable solution is 
to use the arrow keys in the CD track list (view page 146). 

Automatic insertion of pauses between objects 

When importing individual songs (or other audio material) one after the other, 
they will be presented in the track as a sequence of objects. The program 
automatically introduces a 2 second break (space) between each of the 
objects. 

You can change the default pause lenght in the "CD" menu > "Set automatic 
pause length"  
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Several songs in a single long object 

When you record an LP for example, one complete side of the LP will appear 
as one single object in your track window. If you want to split such an object 
into individual song-objects, you will have to search for the transitions in the 
waveform presentation and cut them "by hand". 

In most cases however, it is not necessary to create an individual object for 
each song. Placing track markers at the beginning of the songs is normally 
sufficient. 

Object FX 

All FX can be used on all objects independently from the other objects. Cut 
the object into several smaller objects and edit them individually in the Object 
FX mode.  

Highlight the "Object FX" button of the object by clicking on it.  

If you want to return to the normal "Master FX" mode you can do this by 
simply clicking on the close button ("x") in the upper right corner of the Object 
FX dialog. 

Read more on Object FX in the chapter  "Cleaning FX (view page 72)"! 

Draw volume curve 

 
Use the Volume curve button to activate a volume curve. 

You can use it to add volume curves to your audio material, for instance, for 
compensating volume fluctuations or increasing the volume of quiet passages. 

Volume changes are immediately visible in the waveform display so that it is 
very easy to visually align the volume of different passages. 
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There are two ways to edit these volume curves: 

A "handle" is created by clicking on the curve (in standard mode). You can 
then move it with the mouse and create volume progressions. This method 
should preferably be used if gradual volume changes over longer passages 
are needed. 

Additionally, you can use the Volume curve mouse mode (view page 
39). This allows you to "draw" any volume curve using the mouse 
and lets you create irregular volume progressions quickly. 

 

Tip: The Voice over effect (view page 110) creates volume curves for 
automatic fading in/out based on the audio material in the second track. 

Quick zoom 

For many tasks it is quite useful to enlarge the wave shape display. 

For quickly zooming it is sufficient to click in the timeline, keep the mouse 
button pressed and move it up or down. This way you can quickly zoom the 
cursor in and out at any position without releasing the mouse. 

Set track markers 

In many occasions you will not load single songs, one after the other, into a 
project, but a certain number of them at the same time, for example while 
recording one side of an LP. 

If you want to record this LP on a CD, you should first set track markers at the 
beginning of each song. The track markers can already be set while recording 
in the Record dialogue – "by hand" or automatically by the automatic CD 
Track detector (see below). It is however also possible to set, move and delete 
the track markers afterwards by using the 1click-Burn-Automation (view page 
115). 
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It is furthermore possible to set the track markers directly in the master track. 
Place the position line on the beginning of a new song and press the m key (or 
select the option "set track marker" in the CD menu). The new track marker 
appears just above the position line on the time ruler. 

Automatic track recognition 

There are multiple options for automatically separating the material into CD 
tracks: 

1. during recording in the Record dialog (view page 50) 
2. via the option "Automatically set track markers" (view page 143) (CD menu) 
3. with the help of the burning wizard 

MAGIX Audio Cleaning Lab MX searches for positions where new songs start, 
i.e. the end of a pause. Pauses are normally 0.5 - 3 seconds long. 

However, normally a pause isn't completely silent, 
but might include noises from the record or hissing 
from the cassette. For this reason, MAGIX Audio 
Cleaning Lab MX only detects pauses if the 
recording falls below a certain level (threshold) for a 
specified period of time. 

The higher this level, the more often a pause will be 
detected, but this can lead to incorrect detection of 
pauses at quiet sections in songs. However, if this 
level is set too low, pauses which feature a lot of 
noise like hissing or crackling may not be detected. 

The pause section with marked level, and pause length 

The second step checks to make sure the interval between the pauses is long 
enough. For example, it is very improbable that a recording of the top ten will 
contain pauses a minute long. If this sort of thing is detected, then marking for 
the second pause is removed. 
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Incorrectly detected pause which was removed automatically because the 
interval to the previous pause was too short 

The third step examines the start and end of the audio material more 
precisely: Records always feature a loud bump when the needle is placed on 
the record and another one when it is removed from the record at the end of 
the recording. MAGIX Audio Cleaning Lab MX attempts to recognize these 
noises and to exclude them, i.e. object edges are automatically moved 
inwards to match the start and end of the actual music. 

There are sensible presets for thresholds and times in the track marker 
automation which depend on the selected recording source (records, 
cassettes, CDs/DVDs, Internet, etc.). If these don't work properly, you can 
change them in the Track marker recognition options (view page 155) dialog 
("Options" menu). 

Sometimes it is helpful to place the first one or two markers manually and to 
separate the objects using the "T" key, especially if the volume levels are very 
different. MAGIX Audio Cleaning Lab MX will examine the objects individually. 

Of course, MAGIX Audio Cleaning Lab MX can't recognize the correct track 
markers in every case (e.g. during live recordings or with classical music). If 
you've tried using a number of different settings and still aren't satisfied with 
the results, then you should set the track markers manually. 
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Setting a track marker manually in MAGIX 
Audio Cleaning Lab MX 

You can change the presets for the 
automatic track recognition in the options 
menu. 

 

Check and move track markers 

Before writing your audio material on the new CD, you should check if all track 
markers are located on the correct places. The Track Wizard ("1 Click Track 
Creation and Burn") offers you an easy to read list, which includes all track 
markers that can be selected, moved or deleted individually. 

Move the position line from marker to marker pressing the Alt- and the cursor 
key (arrow keys of the numeric key pad) in order to select the track markers 
directly in the track window, and replay the material from that starting point 
on. If the marker should be unnecessary or placed at the wrong position, just 
click on it and delete it or move it by holding the mouse button. 

If a track marker is dragged in front of or behind another track marker, the 
corresponding objects will change their position in the track. This allows you 
to quickly change the sequence of the songs. This is even more easily done if 
you use the arrow keys in the CD track list (view page 146). 
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Cleaning 

 

Most cleaning functions are activated via the Cleaning FX section –  either as 
master effects on the main screen or as object-related effects on a separate 
"Object FX" page (not available in the MAGIX Music Editor). 

All effects in the "Cleaning" section occur in real-time. You can switch them on 
and off during playback and change their parameters, so that the result of the 
change can be heard immediately. 

Additional cleaning functions can be found in the "Edit" menu. 

Choose preset 

A mouse click on "Select presets" opens the "Cleaning effects" menu. Here (or 
via the "Editing" menu) you can save and load your favourite effect settings as 
"Cleaning effects settings" for your projects or objects. 

With the "Open cleaning FX rack"  command you can display the settings 
dialog for all of the cleaning effects as a large effects rack. 

Different presets (for example, "Restore a poor quality record") are supplied 
with the product and can be tried out right away. 

Cleaning FX presets can also be applied on the "Object FX" page for individual 
objects, as well as for the entire sound via master FX (main screen). 

Using the effect modules 

On/Off: Individual effects modules can be turned off and on via the buttons to 
the left. 

Slider: Each function has a slider that controls the intensity of the cleaning 
effects. 

The effects of the "Cleaning" section include a selection of useful presets 
which can be chosen from a flip menu. Click on the arrow... In most cases it is 
sufficient to select a preset here in order to achieve good results. 

 
Info field: Instead of the analyzer, you can use a help field to explain 
how the selected effect should be used. 
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Edit button: The meticulous can add special settings to the cleaning effects. 
For this the "Effect device" is opened via the button on the right of the module. 
Now the cleaning effects can be edited. 

All effects devices can be activated and deactivated via the "On/Off" button. 
With "OK" you can apply the settings, "Cancel" closes the effects device 
without applying the settings. "Reset" returns the settings to their defaults. 

Cleaning Wizard 

 

This automatically analyses the audio material, selects the appropriate effects 
and applies settings. In the wizard dialog, you can choose whether audio 
objects should be analyzed individually (recommended for audio material from 
different sources or media) or whether all objects should be analyzed together 
(recommended, for example, for a vinyl recording with the same background 
noise disturbances). 
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Step by step 

 

The results of the individual effects introduced are by means of example 
recordings, and then applied to the material in the track window. The cleaning 
assistant suggests the following series of effects: 

1. DeHisser for analog tape hissing (white noise) 
2. DeNoiser for uniform audio disturbances (humming) 
3. DeClicker for popping sounds (scratched records) 
4. DeCrackler for background crackling 

Presets can be selected from the effects available and the output material 
(original) and the result of the effect (as well as the removed audio section, i.e 
the "difference") can be monitored for comparison. 

 
The settings dialog for each effect can be opened via this 
button. 
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Object FX page 

Open the Object FX page using the "Object FX" button 
located directly on the objects in the track window. While 
the effects of the program interface are applied to all 
objects in the master track, the settings of the Object FX 
page are only applied to the individual object. 

 

 Just like on the main interface, you can switch between cleaning and 
mastering effects. All other controls, such as presets and step-by-step 
settings are available on the Object FX page as well. 

 All effects, except for Spectral Cleaning, are also available as object 
effects. In addition, you'll also find Reverb/Echo (view page 96) and 
Resampling (view page 84). 

 

 

Object name with Forwards/backwards buttons: Use them to jump from 
object to object in the master track. The settings of the Object FX page 
are automatically adjusted to the settings of the selected objects. When 
moving from one object to the next, the Object FX button of the 
corresponding object in the master track flickers for a short while to 
indicate that the Object FX page now applies to a different object. 
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Object play status indicates that the activated object is being played. If 
you start playback by clicking on this button, the playback marker will 
automatically be set to the beginning of the activated object. This 
guarantees that you hear your Object FX as well (since your are only 
editing the selected object).  

 Adjust the level of the object here (the middle object handle). The auto 
button located at the level controller of the object performs a 
Normalization (view page 139) to 0dB.  

 

In general the following applies: If in doubt, the blinking Object FX 
button in the master track always indicates which object the 
current settings apply to! 

 

 

 If the Object FX page is not opened, a red Object FX button 
indicates the active object effects.  

 

If you click on the object, the info 
box (view page 42) displays 
which object effects are active.  
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Declicker/Decrackler 

The Declicker efficiently eliminates any crackling and clicking sounds, as they 
are typical in scratched LPs. 

 

This function can be very efficiently used in the "Object FX" mode, if the 
clicking sounds are not present on a whole, but just in some isolated areas. 

First, you will have to find the damaged areas using the track window. Once 
you've found a damaged area, make a cut in front of it and after it, using the 
scissors-tool, so that you obtain an independent object. 

Activate the "Object FX" button of the small object, so that the Declicker will 
only be applied on the area with the clicking sound. 

Marker Declicker 

Alongside normal crackling on a vinyl recording, there can be some more 
noticeable ones on a record which is scratched. If the DeClicker is set highly 
for those sections which are particularly distorted, then it can seem that 
several components of the desired signal will be treated by the DeClicker if 
they exhibit similar characteristics of the distortions. 

To avoid this we recommend setting the DeClicker at a lower setting and 
removing the sharper pops/clicks with the help of the "Marker DeClicker". 
These sections can be set using a click marker (Set click marker). The special 
"Marker DeClicker" affects the audio material (when activated) at these 
positions, and the normal DeClicker can be used for the remaining material. 

"Search clicks" allows you to search the entire project for especially strong 
clicks and have them marked automatically. With the "Sensitivity" controller 
you can set the sensitivity of the search, i.e. the higher the level the more 
clicks will be found (according to intensity). 

Especially strong clicks and audio disturbances can be removed with Spectral 
cleaning (view page 81) (deluxe version only!) 



 

Cleaning 75  

 

www.magix.com

Decrackler 

The Decrackler has been especially designed to smoothly eliminate the 
"cracklecarpet" on old LPs. Stronger, isolated clicking sounds are better be 
eliminated using the Declicker. 

If you think that "crackling" and "clicking" sounds are all the same, listen to the 
examples included in the Cleaning Wizard (view page 70). 

Removed: With this Button the playback is switched into a mode, where you 
can hear the removed clicks and crackles. So you can test, if the 
Declicker/Decrackler removes only unwanted noise or parts of the original 
audio are removed yet 

Declipper 

Should the input level of an audio recording be too high, overmodulation may 
result at the louder parts (the signal peaks). This digital distortion can also be 
called "clipping": At the overmodulated area, the values that are too high are 
simply cut off and the typical, quite unpleasant sounding crackling and 
distortions are heard.  

MAGIX Audio Cleaning Lab MX includes a special function for the elimination 
of these digital clippings and analogue distortion. 

The clippings are detected and eliminated, based on the material of the 
selected object. Lastly, the entire volume of the material can be reduced so 
that the interpolated parts can be played back without overmodulation. 

The declipping-algorithm is especially useful in material, where the excessive 
recording level has caused distorted piano or chorus voices. Affected 
drumbeats however will normally not improve after the use of this function. 

 

CLIP LEVEL: Here you can tell the algorithm from which level on the algorithm 
has to consider the sample as blasted and therefore corrects it. This is an 
important point, as the different sound cards have different clipping 
characteristics. 

Choosing -6dB, for example, will cause that all samples that exceed half of the 
maximum value will be considered blasted and therefore will be calculated 
again.  
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With GET CLIP LEVEL the CLIP LEVEL can be gaged automatically. 

The interpolated signal peaks adjust the whole level, which must be balanced 
out with the GAIN fader so as to avoid new overmodulation. When doing so, 
you should observe the peak meter to the right of the dialog. 

The option "LIMITER" switches on a limiter which reliably avoids 
overmodulation. 

With the INVERSE button you can control whether or not undistorted parts of 
the wanted signal are interpreted as clippings and are filtered out 
unnecessarily. 

Dehisser 

The Dehisser was especially designed to eliminate the band noise, which is all 
so typical for analogue tape recordings, micro-preamps or AD-transducers. 

 

Noise Level: Here you will have to determine as exactly as possible the noise 
level at which the Dehisser starts to work. If you choose a level that is not high 
enough, the band noise will not be completely eliminated. In such a case you 
will notice tweeting sounds (the so called "melodic band noise"). An excessive 
value will result in a dull sound as part of the band noise and part of the 
original audio signal recording will be eliminated by the Dehisser as well (for 
example: air intake sounds of brass instruments) (see Artifacts (view page 80)) 

If the noise level on your recording is low, you should experience no problems 
while adjusting it. 

Adaptive: The value for the noise level parameter is set automatically by 
determining the hiss contained in the signal. If the noise level value is 
changed, its effect is then relative, i.e. the resulting value is determined from 
the automation as well as the noise level fader settings. 

One advantage is that you no longer have to set the noise level value manually 
and that this value can also be adjusted later if the noise share fluctuates, for 
example, if you use music tracks with differing hiss levels within one project. 

If the noise level is constant, a better result may be obtained manually 
(Adaptive off). However, the noise level value must then be set precisely. 
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Audio type: Lets you set the audio material that is to be edited; the algorithm 
is adjusted accordingly. 

Noise Reduction: this option allows you to adjust the damping of the band 
noise in decibel units. In many occasions it is the best solution, not to 
eliminate the noise completely, but to damp it only -3 - -6 dB, hence 
maintaining the natural sound of the original material.  

Quality: The processing quality can be set in two stages. You can use this to 
precisely adjust the values in the dialog for standard quality adjustment 
without skipping playback, and can then select a higher quality for final 
burning. 

Removed: This option allows you to listen to the music that would be filtered 
away by the Dehisser. 

DeNoiser 

The DeNoiser removes persistent background noise like computer humming, 
hissing, noises from sound cards, disturbance from ground wires, interference 
from audio-equipment with high-impedance outputs (e.g. turntables), or other 
device noises. Subsonic noise or rumbling can be removed effectively from 
LPs with the rumble filter. 

The DeNoiser requires a short section from your music which contains a 
sample of the audio distortion, usually from the start or end of the recording. 

When the DeNoiser is activated in the project for the first time, a sample of the 
distortion will be searched for immediately after the playback marker. The 
automatically detected noise sample enables good results to be achieved 
even without opening the DeNoiser dialog. 

For more specific results, open the dialog with the "Edit" button. 

  

Noise sample 

Noise sample: If the automatic noise sample settings were not suitable for 
finding noisy material, then a noise sample can be selected from the list. There 
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are several typical distortions available, e.g. camera noises or power mains 
humming. 

An even more specific option is to create a noise sample yourself. 

Create noise sample 

Length: The length can be set in ms if the "auto" button is switched off, 
otherwise the length of the noise sample will be determined automatically. 

Pick! Generates a noise sample. A short noise sample is taken from the 
selected play range. The playback marker can be moved with the transport 
control when the dialog is open to search for a suitable position. If the 
playback position is between two objects, it's not possible to generate a noise 
sample. Play allows the noise sample to be previewed for testing purposes. 

Wizard: This opens a wizard that helps to create the noise sample. The wizard 
mainly consists of a search function which helps you find the suitable noise 
sample in the audio material. Various distortion types can be selected. 

Save: The noise sample created can be saved in the noise sample folder. It is 
then available as a new noise sample in the noise sample preset list for any 
other project. 

Audio type: Set the type of edited audio material here, and the algorithm will 
be customized accordingly. 

Spectral view 

"Spectral view" shows the spectrum of the noise sample by default. It can be 
switched to spectrogram view by pressing the corresponding button on the 
right-hand side. In this case, the played audio material is shown as a 
spectrogram. The spectral sections removed with by the DeNoiser are 
displayed in red. 

Mode 

Anti-noise: In this mode, the DeNoiser works in an optimized mode to remove 
particularly "noisy" distortions. 

Anti-hum: In this mode, the DeNoiser works in an optimized mode to remove 
tonal disturbances. This includes feedback from power cables, power 
humming, PC fans, video cameras, or ventilation noises. 

If the option "Max. damp tonal noise" is active, then this type of distortion will 
be completely removed. The "Reduction" controller affects all possible existing 
disturbances. This is a sensible step, since tonal disturbances are much more 
annoying than other noise – a small amount of "extra" noise in the recording 
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may be allowed in order to avoid a greater loss of highs throughout the 
desired signal.  

This option can be found in "Hum" mode under the "Noise level" controller in 
place of the "Adaptive" parameter (not available in "Hum" mode). 

Processing section 

Quality: The quality of the calculation can be set in two stages. You can set 
the values in the standard quality setting precisely without influencing the 
playback in any way and select high quality for burning once the material is 
ready. 

Noise level: The threshold of the noise reduction function should be set as 
precisely as possible. Values that are too low will exhibit too low a distortion 
dampening level and result in artifacts like noise or "twittering" (see below). 
High settings produce dull results – useful signals that sound similar to hissing 
noises are also filtered away. Take your time to find the best setting for the 
individual case. If the "Adaptive" option is activated, the setting is relative, i.e. 
in addition to automation. 

Reduction: This sets the balance between the original signal and the signal 
with the applied noise reduction. It's often better to reduce interference 
signals by 3 to 6 dB rather than as much as is possible to keep the sound 
"natural". For buzzing, it’s best to apply complete removal. 

Adaptive: The value for the "Noise level" parameter is set automatically by 
setting the level of the hiss present in the signal. The advantage of this is that 
if a distortion is not constant, the noise level always adapts to the current 
distortion. If the noise sample is not calculated from the signal that is to be 
edited, but rather uses a preset to do so, the difference between the strength 
of the distortion in the audio material and in the noise sample will be equalized 
automatically. If the noise sample has been calculated from the signal being 
edited and the distortion is constant, then the "Adaptive" setting should not be 
used. 

Removed noise: The part of music that was filtered out by the DeNoiser can 
be previewed for testing purposes. 

DeRumble: Here you can activate a special filter for deep-frequency rumbling 
noises. Examples of such distortions are mechanical noises from old record 
players, wind, and subsonic noises in microphone recordings. 

Preset: All the DeNoiser's settings, i.e. the noise sample applied and the 
settings of the processing section can be saved as a preset for later use. 
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Artefacts 

With incorrect settings, the DeNoiser and the DeHisser may leave behind a 
metallic chirping or twittering sound, the so-called artefact noise. The cause of 
this is the incomplete removal of the distortion. The ear is quite sensitive to 
this sound because of its synthetic character. This problem, in practice, only 
occurs in especially difficult cases.  

To achieve the best possible results you should pay attention to the following 
hints: 

 First, select a preset from the selection menu. In most cases the result is 
satisfactory.  

 Be careful when "denoising" the effect: Less is more! The distortion sound 
should no longer be audible, otherwise artefacts may be brought about. 

We recommend removing any DC offset that may exist from the material 
before using it ("Effects" menu > Cleaning > "Remove DC offset" (view page 
80)). 

Remove DC offset 

This function can only be opened via the "effects" menu and can thus only be 
applied to selected objects. This can be useful if your sound card overlays 
your sample with a constant DC offset during recording, which leads to 
crackling during playback or editing. (This is basically always the case with 
recordings that use the integrated sound card of your PC). 
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Options: Here you can enter a minimum DC offset threshold, which indicates 
where DC offset removal will kick in. You can also edit stereo channels 
together to reduce computing time. 

Spectral Cleaning 

MAGIX Spectral Cleaning removes background noise (such as coughing, 
whistling or clapping) from a recording without audibly influencing the signal. 

The music is displayed in the Spectral Cleaning Editor by means of a 
spectrogram (sometimes also referred to as a sonogram). This displays the 
frequency elements with regard to time (see illustration). The frequency level is 
then visualized by a color code or by its brightness, respectively. 

Audible background noises are usually louder than the signal and are generally 
restricted to a certain frequency spectrum. They are therefore highlighted in 
the spectrogram in color and can be easily encircled and removed with the 
mouse.  

  

For example, you can recognize the held 
tone from a pattern consisting of 
horizontal lines that correspond with the 
harmonics of the sound (see illustration 
on the left). A pulsed noise is 
characterized by a vertical line. The right 
illustration displays a tone overlapping a 
short noise. 

Tone  Tone with noise  

In MAGIX Spectral Cleaning Editor you can now simply mark and "remove" all 
noises with the mouse. Lost elements of the original frequency spectrum are 
then added from the signal surrounding the noise in order to avoid audible 
gaps. 

MAGIX Spectral Cleaning is ideal for all short but clear sounds in the music, 
such as clicking, coughing and even short drop-outs, but NOT for permanent 
disturbances such as hiss or noise. In such a case please use the DeHisser or 
DeNoiser. 
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Operation 

Select the object and set the play cursor roughly to the position of the 
distortion. Then open the Spectral Cleaning Editor by clicking on the button or 
via the "Edit" menu -> "Spectral Cleaning". 

 

To remove a distortion, you have to mark it as one. The selection tool 
can be used for this.  

 

You can select as many distortions in the editor window as you want and 
remove them all in one go. 

There are three small buttons visible at the position of your selection. 

Delete: Removes the selection. 

View original: Normally the result of the noise removal is 
depicted in the selection. If you click on this button however, 
you will see the original signal which contains the noise. 
Bypass: Normally the result of the noise removal is played back 
in the Spectral Cleaning Editor. If you click on this button, it will 
play the original signal. 

If you wish to perfect the result, set the play cursor in front of the selected 
distortions and listen carefully to the whole track (see playback section). If 
necessary, change the distortion selection. As a rule of thumb, as short a 
section as possible should be selected. 

Sometimes it's necessary to modify the effects parameters (see Controls, Edit 
selection). If you are happy with the result, then press "Calculate". 

The result of Spectral Cleaning is saved in the original audio file and the editor 
is then closed. 

Controls 

Toolbar 

You can assign various tools to the toolbar using the left and right mouse 
buttons. The selected tools are marked in blue if selected with the left mouse 
button, in red for the right mouse button. 
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Selection tool: Use this tool to modify selections. 

 
Drawing tool: Use this tool to select distortions or to modify the 
selection.  

Double-clicking on the selection applies it to the entire frequency range. 

 
Navigation tool: You can move the displayed range by holding down 
the mouse button and moving the mouse. 

 
Zoom tool: 

 

Left mouse button (click): Zoom in 
Left mouse button (click and drag): Creates a zoom field 
Right mouse button (click):  Zoom out 

Edit selection 
With this setting you can specify how you wish to remove the distortion. All 
selected distortions can be edited in the same way. If you wish to use various 
editing methods in an audio file, you will have to do it in various procedures. 

The following methods are available to you: 

1. Transition: This method attempts to replace the distortion with the help of 
the bordering parts of the music selection. 

2. Transitions (hard): Behave like a transition, but has a more powerful effect. 
This way stronger distortions can be better suppressed. The distortion, 
however, must be highlighted more clearly. 

3. Gap: This mode should be used for very short drop-outs. 
4. Dampening: This only makes the selected distortion quieter, surrounding 

audio material is not faded in. For this reason, ambient noises, unpleasant 
silences and even drop-outs may occur. Only use this mode if a distortion 
is present in a very narrow frequency range or if the surrounding noises are 
very quiet. 

5. Fading in: Corresponds to dampening, only the music is faded back in 
towards the end of the marked selection (music becomes louder). This can 
be a useful mode, if, for example, an impulse-type disturbance is present at 
the beginning of the piece.  

6. Fading out: Like fade-ins, but in reverse, i.e. this mode is useful for 
distortions at the end of a track. 

Strength: Use this setting to meter your changes. A fader which is turned up 
all the way corresponds to a 100% change. 

Left / Right channel: Shows and calculates each channel. If the distortion is 
only audible on one side simply switch off the other channel. 
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View 
In the "View" menu you can select from various view schemes. The schemes 
contain various color scales, but also contain varying time and frequency 
intervals. 

Show grid: Displays a time and frequency grid. 

Click marker 
Click markers help identify especially persistent distortions. They can be 
created automatically using the Marker DeClicker (see Marker DeClicker (view 
page 74) in the DeClicker chapter) or with the "Set click marker" button. 

With the "Next click marker" or "Previous click marker" buttons 
you can quickly move from one click marker to the next. 

Use the "Apply to all" button to set the marking of the distortion on the current 
click marker to all click markers, i.e. the size as well as the position of the 
marker borders in relation to the click marker and in the spectrum. 

If spectral cleaning is used in conjunction with the "Calculate" button, all click 
markers affected will be transformed into normal markers. 

Playback 

Stop: Stops playback. 

Play: Starts playback from the play position.  

Play Loop: Repeats playback within a short range. 

Play Inverse: Plays the signal difference, i.e. the removed sound elements. 

Calculate: Performs the calculation and closes the dialog. 

Abort: Aborts the editing. 

Help: Opens the help window. 

Tutorial Video: The tutorial video briefly explains the possibilities of Spectral 
Cleaning. 
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Tempo/Resampling 

This effect is only available as an object effect (view page 72). 

The fader lets you change the playback speed of objects so that they are 
better aligned. The effect can be applied in two ways, either as resampling or 
as timestretching. You can change the mode in the preset list at the very 
bottom. 

 Resampling mode can be used to change speed and pitch just like on a 
cassette. Use this mode to adjust LP recordings made at the incorrect speed. 

 Timestretching mode applies a high-quality timestretching algorithm 
(universal HQ) to keep the pitch constant in spite of speed changes. Use this 
mode to adjust the tempo of different tracks to match each other without 
influencing the pitch, e.g. for a DJ mix. 

The effect is also available as a mouse mode (view page 39) for changing the 
tempo across a larger range of values. 

Resampling for incorrect record speeds 

If you want to record a record that was recorded at 78 rpm, then you normally 
have a problem: These older shellac LPs aren't able to be played back by 
most turntables. With the help of this resampling technology, it's possible to 
playback the record at the incorrect speed, record it, and then correct the 
speed with a single click. 

Different presets have been provided for this. The first number indicates the 
speed at which the record was played back, and the second shows the speed 
that it should be played at. For example, if an older 78 rpm shellac record was 
played at 33 rpms, then you would use the "33/78" preset. 

A second group of presets are for adjusting wave files with different sampling 
rates to the project. These are selected automatically when this sort of wave 
file is loaded into the project. The first number here is also the sample rate of 
the project (for playback, normally 44.1 kHz or CDs), and the second is the 
wave file (the target playback rate). 
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Mastering 

 

The mastering functions are activated via the Mastering section –  either as 
mastering effects on the main screen or as object-related effects on a 
separate Object FX page (not available in the MAGIX Music Editor).  

All of the mastering effects function in real time. This means that you can 
switch them on and off during playback and change their parameters so that 
the result of the adjustment can be heard immediately. 

Choose preset 

A mouse click on "Select presets" opens the "Master effects" menu. Here (or 
via the "Editing" menu) you can save and load your favorite effect settings as 
"Mastering effects settings" for your projects or objects.  

With the "Open mastering FX rack" command you can display the settings 
dialog for all of the mastering effects as a large effects rack. 

Different presets (for example, to restore a poor quality tape recording) are 
supplied with the product and can be tried out right away. 

Mastering FX presets can also be applied to the "Object FX" page for 
individual objects, as well as for the entire sound via master FX (main screen). 
Since the available object effects are different from the master effects, many 
settings may be ignored. For example: The echo/reverb settings will be 
ignored if the preset is loaded as a master effect (the master section does not 
include an echo/reverb device). 

Using the effect modules 

Please read the section Using the effect modules (view page 69) in the 
Cleaning effects (view page 69) chapter. 

Step by step 

The Mastering Assistant applies several mastering effects in a sensible 
sequence. All effects will now be introduced by means of a suitable recording 
example and then applied. 
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It is recommended that these effects are used in the following sequence: 

1. Stereo processor 
2. Graphic equalizer 
3. Brilliance enhancer 
4. MultiMax 

Using the mastering assistant is the same as using the Step-by-step (view 
page 71) cleaning assistant.  

Object FX window 

Read the section "Object FX window (view page 72)" in chapter "Cleaning FX 
(view page 69)"! 

Enhancer 

The Enhancer enables the justification of the audio material in the stereo 
panorama to be adjusted. If the stereo recordings sound unfocused and 
undifferentiated, an extension of the stereo base-width can often provide 
better transparency. 

Use the maximize function to move the echo and improve the stereo picture, 
for example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the 
complete panorama. The reduction of left and right levels is displayed under 
the control buttons. 

Pan-direction: Use this controller to move the sound source from the middle 
into stereo panorama. The signals at the outer edges of the sound picture 
remain unchanged. 

Multiband: This option switches from "Stereo FX" to "Multiband" mode. 
Stereo editing only applies to the middle frequency, the bass and highs remain 
unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono 
(extreme left), unchanged base width (normal stereo), and maximum base 
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width (wide, extreme right). Raising the bandwidth (values over 100) 
diminishes the mono compatibility. This means that recordings edited this way 
sound hollow when listened to in mono. 

Maximize strengthens the spatial component of the recording, which also 
increases the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the 
phase relation of the audio signal. You can use it to review the orientation of 
the signal in the stereo balance and the effect of the stereo enhancer. To 
maintain mono-compatibility, the "cloud" shown should always be higher than 
it is wide. 

Equalizer 

The Equalizer consists of two modules, the Parametric 4-band Equalizer and 
the 10-band Graphic Equalizer. 

Parametric Equalizer 

The parametric equalizer consists of four filter bands for adjusting the overall 
sound of the music track. Each band is a filter with a typical "bell shape". 
Within a certain frequency range and around an adjustable middle frequency, 
you can increase or reduce the signal level gain. The width of this frequency 
range is called bandwidth. The bandwidth is defined by the Q value. The 
higher the Q value, the narrower and steeper the filter curve. 

You can influence the basic sound of the mix by increasing and decreasing 
the broadband to give it more "depth" (lower center = 200-600 Hz) or more 
"air" (highs = 10Khz). You can also decrease the narrow bandwidth (high Q 
value) in the frequency response, e.g. to remove disruptive frequencies. 

 

 

Graphic: The resulting frequency path of the 
equalizer is displayed in the graphic. The 
frequency is spread out horizontally, the 
increase or decrease of the respective 
frequency, vertically.  
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The blue bullets 1-4 symbolize the four wave bands. You can move them 
around with the mouse until you find your desired frequency response. 

 

Peak meter: The peak meter gives you control over the output level of the 
equalizer. The adjacent master gain controller can be used to balance the level 
with the EQ. 

 Edit: The "Edit" button opens the fine tuning for the four bands: 

 

Parameter selection: With the buttons on the right you can select the 
parameter that can be adjusted with four faders of each band. Furthermore, 
there are number keys to enter every parameter of the bands. 

Gain dB: These controllers allow you to raise or lower the filter. Setting the 
controller to 0 deactivates the filter and doesn’t use CPU power.  

Freq. Hz: The center frequency of the individual filters can be set between 10 
Hz and 24 kHz with the frequency controllers. Freely choosing the frequency 
enables multiple filters to be set to the same frequency in order to have a 
greater effect. 

Q (bandwidth): Set the bandwidth of the individual filters between 10 Hz and 
10 kHz. 

There is still a peculiarity among bands 1 and 4; The filter curve for these 

bands can be changed from a normal "peaking" EQ filter ( ) to "shelving" 

(  ) (this is the basic setting) and high (band 1) or high-cut (band 4) . 
When using the "shelving" filter, a soft increase or decrease in all frequencies 
happens above or below the filter frequency, and the Q parameter does not 
have a function here. With a low-cut or high-cut filter, all frequencies below 
(low-cut) or above (high-cut) the set frequency are filtered out. 
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Graphic Equalizer 

The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) 
and supplies them with separated volume controls, which allows you to 
achieve many impressive effects, from the simple rising of the bass, to total 
sound transformation. If you raise the low frequencies too much throughout 
the whole level, it can cause distortions. In this case, lower the master volume 
using the master volume control on the main screen. 

 

Thumb Controls: All of the 10 frequency areas can be raised or decreased 
separately by the 10 volume controls. 

Link Bands: Using this switch you can match the frequency areas in a flexible 
way to avoid the overemphasizing of single frequency areas that sound 
artificial. 

A/B: If you have selected a preset for the effect and later you change it 
manually, you can compare the original-preset-sound with the new 
adjustments using the A/B-switch. 

Reset: Reset inserts the sound effect into the neutral starting position where 
no processing power is used and where no effect is calculated in the sound. 

Touch-screen (right EQ-Section): This is the "sensor-field" of the EQ: Use 
your mouse to draw a curve that will be transferred immediately into the 
corresponding EQ control adjustment. 

Brilliance Enhancer 

The Brilliance Enhancer is a high-end audio tool with which, for example, 
losses in high frequencies, which occur with MP3 compression or while 
recording older records, can be regained. 

In contrast to the equalizer, which only works on the currently available 
frequency, the brilliance enhancer calculates new harmonics and noticeably 
revitalizes the sound from residual material 
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Soft: Activating this option depends upon your own perception of sound. If 
you would like to produce a more lurid sound (such as grunge) you should 
deactivate the "soft" option. This option does, however, reduce eventual 
distortion. 

High Quality: This option improves the results of the effects while demanding 
more of your computer’s performance. As with the "soft" option, your own 
notion of sound should come into play when choosing this option. 

Sound Cloner 

With the "sound cloner" you can determine the sound characteristic of a song 
and transfer it to your other recordings. This way you can, for example, create 
a Pat Metheny song in the style of Madonna. Load a track you really like, set 
the song's playback position and press the "Get sound" button in the sound 
cloner. The sound's characteristics are now calculated. As a preset sound 
clone, it is now immediately available to you and can also be stored via "Save" 
for later use. 

By loading the "clone" from the preset menu, you can use it on the sound 
material. With the slide control, you can regulate the intensity of the sound 
transmission. 

 

The sound cloner is a kind of automatic 1024 band equalizer. Its filter curve 
(compare the touch screen in the "normal" EQ) is a result of the mean of the 
cloned sound and output sound. When loading the preset, the sound cloner 
uses the audio material beneath the playback marker as the basis for filter 
settings which then apply to all objects in the master, but are actually only 
intended for this object. So if your output material on the track comes from 
various sound sources, the sound cloner should definitely be used as an 
object effect. 

The "Settings" menu of the sound cloner also contains a few useful filter 
settings besides its "clone" presets. These are independent of the source 
material and can be used as a master effect. 
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Sound cloner - FFT filter 

Use Edit  to open the dialog which contains the fine-tuning settings for the 
sound cloner's FFT filter.  

 

A red line can be drawn in the graphic field using the mouse. The left side of 
the graphic is for the lower frequencies of the sound, the right for the higher. A 
"mountain" in the left part of the graphic creates a large increase in bass, and 
a similar figure in the right increases the highs. 

Freehand: With the pencil you can draw "freehand". Draw or rotate a straight 
line by pressing and holding the "Shift" key. 

Draw quantization: This activates a quantization function to draw straight lines 
and angled figures. The farther away from the curve you are, the wider the 
bulge in the range. This effect can be increased with the "Ctrl" key. 

Reshape tool: This drawing tool lets you bend existing curves. Deformed 
curves can be achieved by pressing the mouse button repeatedly. 

Navigation tool: Drag the display area. 

Zoom tool: With the left mouse button you can zoom into the selection; zoom 
back out with the right. Keep the left mouse button depressed to feed along 
the zoom area. 

Reset: The "Reset" button quickly allows you to replace the filter curve with 
that present in the output state.  

Preset: Access the presets for definite applications here. 
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Strength: The "Strength" slider allows you to enhance or diminish the intensity 
of curvatures. The result is a stronger or weaker modulation.  

Vol:The "Volume" controller controls the volume of the material.  

Sound cloner: With the sound cloner you can determine the sound 
characteristic of a song and transfer it to your other recordings. This way you 
can, for example, create a Pat Metheny song in the style of Madonna. Load a 
track you really like, set the song's playback position and press the "Learn" 
button´. 

Scale options: Accesses a settings dialog with the following options available: 

Freq: This switch lets you choose between a logarithmic ("log") or a linear 
("lin") frequency scale. The logarithmic display corresponds to the human 
perception of volume. Like on a keyboard of a key instrument, the (graphic) 
spacing of the intervals, i.e. halftones, is uniform across the entire range. 

Freq.log: The upper labeling of the graphic can be switched between output 
in "Hz" or "Notes". Note output is only possible via logarithmic frequency 
display ("log").  

Value display: Here you can set a logarithmic or linear display as well as an 
enlargement of the filter curve. 

Value range: Here you can set the displayed value range in dB. 

Curve display: Here you can switch between a bar and a curved display.  

MultiMax 

  

MultiMax is a compressor with three independent frequency bands. The 
dynamics are edited separately for each band. 

The advantage of a multi-band compressor in comparison to a "normal" 
compressor is that the "pumping" tendency and other disturbing side effects 
are dramatically reduced while editing dynamics. For instance, it can prevent a 
bass top peak from "dragging down" the entire signal. 
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Multi-band technology also lets you specifically edit individual frequency 
ranges. 

Link bands: When this button is activated and one fader is adjusted all faders 
are changed in the same ratio. The type of dynamic editing is not influenced. 
Limiter: MultiMax includes a limiter that prevents clipping by automatically 
lowering the level. Quiet parts remain unaffected.  
High quality: When the "High quality" setting is activated, an even more 
precise algorithm is used, but it also requires more processing power. We 
recommend that you switch on this setting before you export the project. 
Setting the frequency bands: The settings of the frequency bands are 
changed directly in the graphic. Simply click on the separator lines and move 
them. 
Bass/Mid/High: These knobs control the level of compression for each 
frequency band. 

Presets: In MultiMax you can use the presets to open two more special 
functions. 

 Cassette NR-B decoder: MAGIX Audio Cleaning Lab MX simulates decoding 
of Dolby B + C noise suppression if no Dolby player is available. Casettes 
recorded with Dolby B or C sound more muffled and slurry if played back 
without corresponding Dolby.  

 DeEsser: These special presets are for removing overstressed hiss sounds 
from speech recordings. 

Dynamics 

Fundamentally, the compressor is an automated, dynamic volume controller. 
The dynamics of a piece are limited, loud sequences remain loud, quiet 
sequences become louder. Compression is often used to add power to audio 
material or to increase the loudness. The level of compression is adjusted by 
the ratio controller, while the activation threshold is determined by the 
threshold. You can also influence the attack and release. 

Editing is carried out using a “look-ahead” method, similar to high-quality 
studio appliances. There are no peak over-modulations or other artifacts, as 
the algorithm can never be ‘surprised’ by sudden level peaks. 

 

Sensor field: You can intuitively influence  the sensor field  of the 
compressor with mouse movements. The graphics  color and the respective 
effect settings change in response to each other. 
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Ratio: This parameter controls the amount of compression. 

Threshold: Set the threshold, above which compression is applied. 

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short 
attack times can create an undesirable "pumping" sound, as the volume is 
quickly reduced or increased correspondingly. 

Release: Sets the algorithm's reaction speed to falling sound levels. 

A/B: If you have selected a preset for the effect and make manual changes to 
it later, you can compare the original preset sound with the new settings by 
using the A/B-button. 

Reset: This resets the effect device to its original neutral starting point where 
minimal processing power is required and no effect is added to the sound. 

Load/Save: Here you can save the current settings as an effect file so that 
they can be used on other projects as well. 

Special presets 

In the compressor you can use the presets to open further special functions. 

Dynamic expander: Too high a compression rate will result in audible noise 
(usually defined as a pumping sound). Radio recordings in particular are 
recorded with very high compression rates to increase the perceived volume. 
Unfortunately, compression reduces the dynamics (interval between the 
quietest and loudest part). The expander enhances the dynamics of the 
recording. 

Noise Gate: This cleaning function suppresses noises which are completely 
below a certain volume threshold. This lets you create, for example, song 
transitions that are entirely noise-free. 

Leveler: This setting automatically sets the entire material to an identical 
volume level. The volume control knob is no longer required. You can use this 
function to equalize greater volume differences within a song. To equalize 
volume variations between different songs you can also use the function 
"Normalize loudness" in the "Effects" menu. 
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Reverb/Echo 

 

The reverb effect device offers newly developed and very realistic reverb 
algorithms to add more room depth to your recording. 

Reverb is probably the most important but also the most difficult effect to 
generate. 

Parameters 

The reverb effect has the following parameters: 

Size: defines the size of the room (or the system for the plate and spring). The 
larger a room, the longer the sound travels between walls or objects. With 
some low "size" settings you can also reduce the distance between the 
individual reflections. This allows resonance to develop (accentuated 
frequency ranges), which can sound oppressive if the reverb sustain is too 
long. 

Time: With this knob you can adjust the echo time and determine how much 
of it will be absorbed and, simultaneously, the reverb's decay. 

Color: You may influence the sound characteristics of the effect within certain 
limits. The effect of this controller depends on the used preset. In rooms, 
"Color" controls the dampening of the highs in the reverb (from dark to bright) 
as well as pre-filtering of the signal. With plate and spring presets, this fader 
determines the dampening of the basses as well. 

Mix: This controller sets the mix ratio between the original and the edited 
signal. For rooms, you can therefore move a signal further into the room by 
increasing the effect share. The last four presets are intended for use in an 
AUX channel of the mixer and are set to 100%. 

Presets 

The presets represent the basic settings for the various room algorithms, 
which can still be varied along with the other parameters. Hence, they are 
more than just simply parameter sets. 
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Delay 

This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more 
the control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the 
left, there is no echo at all; turn it completely to the right and there are 
seemingly endless repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry 
signal) is subjected to the echo (wet signal). Application of this effect in an 
AUX bus requires the controller to be set to 100% (all the way to the right). 

Plug-ins 

 

Microsoft's DirectX and VST-compatible plug-ins may be used for effects 
calculation in MAGIX Audio Cleaning Lab MX. This allows you to use almost 
any effect algorithms of third parties in addition to the effects integrated in 
MAGIX Audio Cleaning Lab MX. 

Some of the supplied effects will be loaded as Plug-ins. These are: 

 Tape simulation 
 De-esser 
 Energizer 
 AM-Track SE 
 Chorus 

Selection menu: Select the plug-in via the selection menu on the right hand 
side of the module. For this, you will need to have plug-ins installed on your 
computer. The path to search for installed VST plug-ins can be set in the 
"Options" menu via -> "Set path settings". All recognized plug-ins will be 
added to the menu list. 

Edit: The selected plug-in is opened to define specific effect settings. 

VST Plug-in Editor 

The VST Plug-in Editor can be opened by right-clicking on the instrument's 
name in the MIDI Editor, via the corresponding plug-in slot in the Mixer, or via 
the "VST Instruments Editor" entry in the instrument list. 
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The Instrument Editor has two views, the so-called "GUI" of the plug-in 
(Graphical User Interface) and the parameter view. This is either automatically 
activated when the VST plug-in does not have its own GUI or can be used if 
the GUI of the plug-in is too unclear or takes up too much space on the 
screen. The parameter view displays the eight parameters of the plug-in as 
sliders. In the File menu you can change between these views (plug-in 
dialog/plug-in parameter). 

Load/save patch/bank: The instrument settings can be saved and loaded in 
the patch formats typical for VST plug-ins (*.fxp) and bank formats (*.fxb). 

Random parameters: This function can be an important source of inspiration. 
However, before using it please save the current preset you've just created as 
this feature does not ask before it is applied. 

Menu program: Here you can select the presets integrated into the plug-in or 
loaded via the File menu. 

Tape simulation (plug-in) 

Tape simulation offers you the possibility of giving your recordings an "analog 
touch" by imitating typical aspects of a tape recording. In a lot of studios, 1" 
and 2" tape machines are still used because they are thought to create a 
fullness of sound, "warmth" and "saturation" that contrasts with the more 
neutral and analytical sound of digital technology. 

There are numerous factors that are decisive for the sound expressiveness of 
tape-based recordings. Some of these are: 

 Distortions that occur when the tape is played in the saturation range, 
 changes to the frequency response, since recording and playback-side filter 

steps prepare the signal. All machines also feature more or less pronounced 
peaks in the frequency spectrum, above all in the bass range (so-called "head 
bumps"), 

 loss of highs through self-erasure resulting from the HF stream ("bias", 
pre-magnetization) and intermodulation between the wanted signal and the 
HF signal. 
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Level: Sets the input level. You decide when the "virtual tape" is saturated and 
how strong the effect of this color effect should be. The signal will gain more 
"loudness". 

EQ low/hi: Adjusts the frequency response (spectral balance controller). You 
can choose whether you would like the output signal to have a richer bass 
level or whether it should have more highs. This adjusts the pre-filtering at the 
"recording end" as well as playback equalization. 

However, please note that the frequency response of the simulation will not be 
neutral even if the "EQ low/hi" controller is set to neutral. There will always be 
some slight frequency-selective amplification.  

The distortion resulting from use of the tape simulation can quickly create 
"acoustic fatigue", especially for material that is rich in highs. A direct 1:1 
comparison with the tape section switched off reveals the differences more 
easily. Slight editing with the simulation is generally sufficient to achieve an 
"analog touch". 

De-Esser (Plug-in) 

 

If you have ever edited or restored your own spoken or sung recordings, 
you've most certainly come across the occasional unpleasant loud "S" or 
"SSHH" sound. This hissing can ruin an otherwise perfectly good recording. 

The De-Esser works according to the "dynamic filter" principle, meaning that it 
contains a filter switch (band pass and high cut), whose frequency and 
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implementation depends on the input signal and the recognized "problem 
area". 

So-called detector circuiting reacts to the input peak levels in the mid and 
high areas. This level recognition occurs automatically in a comprehensive 
modulation area. For this reason the De-Esser can manage without having to 
set a threshold. 

Using the De-Esser is quite simple: 

You have to notify the detector circuiting which areas contain the "S" or other 
sibilant sounding distortions. A switch for male and female voices has been 
designed for this. Depending on the switch setting, it will select the internal 
parameters for the most exact recognition possible. 

After you have set the switch, the Reduction fader has to be adjusted enough 
that the "S" parts of the signal are reduced to a normal level. 

An overly strong reduction of "S" sounds in speech or song recordings can, 
however, result in a "lisping" sound. Often, a small reduction can be enough to 
balance the ratio levels. 

The Removed Noise button can be used to control the recognition and 
adjustment of the De-Esser. With it you can pick up the detector circuitry and 
evaluate whether the switch is in the correct position. 

You can also try to edit other sound sources, partially complete mixes and 
drum recordings with the De-Esser. For the latter, the adjustment control can 
bring about an improvement in the sound of cymbals and high hats that were 
too loud. For humming signals/complete mixes, the De-Esser (discreet setting) 
can be used to design the sound characteristics more softly. 

For such 'forced adjustment' the correct setting for the switch can be found 
out quite simply by testing ot out. 

Energizer (plug-in) 

The Energizer belongs to the so-called psycho-acoustic processors genre. 
These devices are used in the studio, acoustic irradiation, and restoration 
areas in order to enhance the sound. 

An effect like this usually can only be partially achieved with standard methods 
like equalizing since an equalizer can only compile the frequency parts that are 
already in the signal. Additionally an excessive increase in the signal (of the 
highs) increases the chances of hissing. 
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With bass the problem often arises that for each device in an analog 
processing chain (for example, tapedeck, mixing desk, pre-amp) slightly 
delays the signal compared to the remaining spectrum. This type of phase lag 
cannot be restored with an EQ and increasing the depth often results in a 
washed-out and feebler sound. 

Psycho-acoustic devices are based on our hearing's ability to perceive 
attributes like "freshness", "liveliness" and "naturalness" in a recording as a 
result of various parameters. One of them is the harmony spectrum. The mid 
and high frequency ranges of a loudly played instrument are richer than those 
of a quietly played instrument. The "Exciter" tries to imitate this property with 
artificial harmonies. However, this type of method cannot function statically as 
the noise and low-level signals will be influenced otherwise. 

The order in which individual frequencies are heard is just as important for 
lively sound. 

The psycho-acoustic method used in the Energizer is based on a combination 
of frequency-dependent phase correction, additional harmonics creation and 
recognition of so-called transients (short signal peaks). 

The Energizer is subdivided into a bass and middle/high area. In both of these 
areas, the audio can be enhanced independently of one another. 

The parameters of the Energizer 

 

The available effect presets cover typical areas of usage and are already set 
up as presets in order to, for example, format a CD for playback on the car 
radio, use as a soundtrack for your home entertainment system or for 
restoring distorted frequency response curves of old records. The Energizer 
can have a drastic effect on the sound even if only small changes are made to 
the parameters. So that you know which faders to change to get the audio 
results you want, the following section describes the available faders in detail. 

Low tune: Here you can tune the bass processor to a specific input frequency 
(between 50 and 150 Hz). This is the preferred frequency at which, for 
example, a kick drum or an acoustic/electric bass is played. The phase 
position of the bass range can be influenced according to the set frequency, 
resulting in deeper sounds sounding more "succinct" and "broader". 

Low attack: Using the transient recognition fader the attack behavior of the 
tuned range can be increased (fader to the right) or decreased (to the left). 
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You can use this to create a "hard" or "dynamic" bass foundation or have a 
range sound "legato" or "soft. 

Low mix: Here the processed bass signal is mixed with the unprocessed input 
signal. Please note that material that is already highly modulated may become 
overmodulated/distorted. For strong increases in the bass you should, if 
required, reduce the source material in order to have enough reserves. It is 
also recommended that you use the Audio Cleaning Lab Limiter as the next 
step. 

High tune: This fader specifies the input frequency of the high tone circuitry 
(between 1 and 10 kHz). A part of the input signal is filtered and a phase lag is 
created depending on its frequencies. Simultaneously, the dynamic harmony 
is enhanced. When turned to the left you can influence the mids and highs of 
the signal so that, for example, the "articulation" of speech and instruments 
can be edited. The further up the frequency you go, the more the harmonies 
or bright sounds, like drum cymbals, are registered. You can use this to add 
"shine" or "silkiness" to your recordings. 

High stereo width: Use this fader to specify whether the signal that's added to 
the high tone processor should be edited in mono, stereo or as a broadened 
signal if at all. This way you can specify whether the range should be compiled 
from the stereo mids of a recording or from the parts of the pages (for 
example, room information) 

High mix: Here you can specify the amount of data from the high-frequency 
processor that should be mixed into the original sound. 

Tip: At the beginning when using psycho-acoustic devices there is a danger of 
overkill. We recommend regularly toggling from unedited signals to processed 
ones. In order to make subtle changes in the sound it is often enough that the 
change be just about audible or that when switching off the effect, you get the 
feeling that there's something missing. If the effect sounds like it's in the 
foreground, this usually means that it's exaggerated too much. 

AM-Track SE (plug-in) 

AM-Track SE is a combination of an analog compressor and a tape simulator. 
This professional plug-in lends more power and vitality to your audio material. 

Please click on the Help button located in the upper right-hand corner of 
the Plug-in dialog for more information about how to use the AM-Track 
SE compressor. 
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Sound Effects 

Surround Mode 

MAGIX Audio Cleaning Lab MX offers a convenient mode for creating 
surround sound. To play back surround sounds, you require a stereo system 
with a decoder compatible with Dolby Pro Logic, and loudspeakers positioned 
to the back. Surround sounds can even be burnt onto CD or exported as MP3 
files! 

 

When the "Surround" button is activated, a second stereo track for audio 
material appears. 

The Surround Panning window (view page 103) also opens at the same time. 

Here you can determine the position in the space from which the contents of 
the track should emanate. The default setting position is "Back – Centre". 

Particularly practical is to combine the Surround mode with the Spatial 
Acoustics Simulator in MAGIX Audio Cleaning Lab MX. The simulator offers 
several surround reverbs whereby the back of the reverb automatically routed 
to the surround track. A fantastic special impression is the result – try it out for 
yourself! 

Surround Editor 

 

Graphics: The blue circles are the loudspeakers -- three in front (right, left and 
center) and two at the back (right and left). The red circle is the position of the 
acoustic source, as perceived by the listener. Place the acoustic source in the 
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space by shifting the red circle with the mouse; downward motion moves it to 
the rear, upward motion moves it forward. The preset position is at the back 
and centered. This is the "pure" surround signal. 

Surround active: Activate the Surround Mode and the second track opens 
simultaneously. Audio material on the second track (‘surround’ in the track 
display) can now be positioned in the space. 

Width: Determines the dimensions of the sound field. The sound field is made 
up of the concentric circles that clarify a drop in the signal level dependant 
upon the distance from the acoustic source. A circle corresponds a drop in 
the dB level. The smaller the width, the smaller the sound field (and the faster 
the signal level drops as the distance from the acoustic source increases)and 
subsequently, the virtual space is perceived as being larger. 

Switch different items of the display from visible/invisible: 

Output dB: Relative level in dB at the individual loudspeakers (0db = full level, 
-90 dB = silence) 

Loudspeaker names: Name of the loudspeakers according to their position in 
the space 

Sound field: Concentric circles around the acoustic source that clarify a drop 
in the signal level dependant upon the distance from the acoustic source. A 
circle corresponds to a drop in the dB level (see width ) 

Surround Reverb: Reverb is added to the surround signal if this option is 
activated. 

Surround Transitions 

MAGIX Audio Cleaning Lab MX can also create so-called surround transitions 
in addition to normal crossfades (see also Editing in Track View (view page 
63)) In this case a movement of the music tracks within the room is simulated 
in addition to the volume change when crossfading. The old track will fly away, 
and the new one will come flying in. 

You can create a surround transition by first creating a normal crossfade. 
Move an object backwards in the time line across the preceding object and 
then fade it by using the upper handle. The previous object is faded in the 
same manner and a so-called crossfade is created.  

 
Different presets can be selected from the "Surround Transitions" 
submenu by clicking on the crossfade symbol. 

This is done more easily by using the following menu command: "Edit" menu > 
"Create Surround Transitions". A surround transition is created for each 
object. 
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Acoustics simulator 

Open the acoustics simulator via the menu "Effects" > Reverb/Echo. You must 
select the object you want to apply the effect to first. 

 

This very efficient high-end effect can transfer the sound characteristics of any 
room and effect device to your audio material. To do so, a so-called impulse 
response is extracted in the original room, this is like recording a "bang". 
There are several impulse responses to choose from; listen to the list and you 
will be able to identify the type of room easily. Different sound characteristics 
of rooms, such as reverb, reflections, echo, damping and resonance can be 
"copied" using this method. 

Sophisticated algorithms can "add" your audio material to "this room" – after 
that a "dry" voice will sound like it was sung in a church. The quality of the 
reverberation and spatial impression is much higher than all standard synthetic 
reverb methods. No more undesired crackling, rattling, and rumbling. 

Some impulse responses are available in surround format, that is, the reverb 
was recorded separately at the front and at the back of the original room. This 
way, MAGIX Audio Cleaning Lab MX can reproduce this surround reverb in 
your audio material. Simply activate the "Surround" option in the dialog. 

MAGIX Audio Cleaning Lab MX automatically changes into the surround 
mode, the audio material with the surround reverb is placed on the 2nd track. 

Functions of the controls: 

Preset: Select the room impulse response you want to use for the room 
acoustics simulation. Click on "Play" to start playback of the impulse response 
for testing purposes. Some presets have the word "surround" in their names, 
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they contain separate impulse responses for the front and rear reverb share. 
The result is a very high-quality surround reverb. 

Apply to original object: If you activate this option, the original audio object in 
the first track is edited and room reverb is added. 

Surround reverb: If you activate this option, a 2nd object with the reverb is 
produced in the 2nd track. To do so, the 2nd track changes into surround 
mode, so you can hear the reverb from the rear via a Dolby pro Logic 
compatible stereo set. 

Reverb share: Adjust the ratio of original sound to hall share here. To generate 
a surround reverb, deactivate the "Apply to original object" option, activate the 
"Surround hall" option, and set the controller to 100% reverb share. 

Reverb volume: Adjust the volume of the reverb here. This is useful if you 
want to balance the different depths of impulse responses. 

Resampling/Timestretching 

The pitchshifting/timestretching/resampling editor opens. This effect can 
change the tempo and pitch of the audio material separately. The effect is also 
available as a mouse mode or object effect. The dialog's advanced settings 
options and the pitch changing options are missing, however. 

 

Algorithm: Selects the applied timestretching process. 

Time factor calculation: All algorithms in this dialog apply a time factor as the 
input parameter. The input fields for the group "Time factor calculation" enable 
convenient detection of the time factor from the desired new length or a new 
tempo in BPM in relation to an old tempo (required beforehand). 
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Pitch (semitones): For any algorithm except resampling, the pitch can also be 
set independent of the tempo. Use the pitch fader beside the factor fader to 
experiment. 

Play/Stop/Play orig.: "Play/Stop" can be used to immediately control the 
result of the algorithm. "Play orig." plays the unedited material for comparison. 

Algorithms for timestretching/pitchshifting 

 Standard: Timestretching and pitchshifting in standard quality. This method is 
suitable for audio material without a pronounced beat. Beat markers are 
evaluated to improve audio quality. 

 Smoothed: Timestretching and pitchshifting for audio material without pulsing 
elements. The method is suitable for polyphonic orchestral instruments, 
pauses, speech, and singing. Beat markers are not evaluated.  
In this case, a considerably more complex algorithm is used which requires 
more processing time. The material can also be processed with very large 
factors (0.2... 50) without causing serious artifacts. The material is 
"smoothed" to make the sound softer and emit it at an adjusted phase level. 
This smoothing is hardly audible, for example, with speech, singing, or solo 
instruments. Problems may arise with more complex spectra (sound mixes 
from various instruments or finished mixes). For smaller corrections (factors 
approx. 0.9... 1.1), we recommend setting the smoothing level as low as 
possible. 

 Beat marker slicing: Beat-synchronous timestretching and pitchshifting via 
splitting and temporal repositioning. Exactly set beat markers are required at 
the beats or transients. The markers can be generated in real time 
(automatically) or read from the WAV file if available (patched). In the deluxe 
version's included MAGIX Music Editor, a patching tool is provided for users 
to set the markers themselves. The algorithm is suitable for rhythmic material 
that can be divided into individual beats or notes. This requires a low audio 
level before each beat or note. 

 Beat marker stretching: Beat-synchronous timestretching and pitchshifting in 
standard quality. The material is stretched between beat markers positions so 
that the beats or attacks at the beat marker positions are not impaired by 
stretching. The markers can be generated in real time (automatically) or read 
from the source file if available (patched). This method is suitable for rhythmic 
material that can not be divided into individual beats or notes because the 
beats or notes overlap each other. 

 Universal HQ: Universal methods for timestretching and pitchshifting in very 
high audio quality. Suitable for all types of audio material. Beat markers are 
evaluated to improve audio quality. This method requires a lot of time for 
processing, so application of the "Calculate all real-time effects (view page 
138)" function ("Edit" menu) is recommended. 

 Monophonic voice: Timestretching and pitchshifting for vocal solos, speech, 
or solo instruments. The material must not contain background noise, and 
excessive reverb may also be detrimental to the use of this method. With 
suitable material the audio quality is very high. The "Correct formant factor" 
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option preserves formants if pitches are changed. These are characteristic 
basic frequencies of the voice that are independent of the pitch that is sung. 
In other words, the characteristic discoloration of pitch ("Mickey Mouse") 
effect does not occur in this case. The formants, however, can be shifted by 
+/- 12 half tones. This achieves suitable vocal distortions. Beat markers are 
not evaluated.  

 Resampling: Pitch shift and tempo cannot be changed individually. This 
method requires considerably less CPU time. If the pitch is increased or the 
sample is shortened, then resampling is almost completely free of loss, and 
the sample material will suffer almost no damage. In other cases, resampling 
causes loss of overtones. For example, if the length of a 44.1 kHz sample is 
doubled, then the freqency level of the result will be limited to 11.025 kHz. 
The sound is the same as when the playback speed of a record player or 
tape recorder is changed. 

Chorus (Plug-In) 

Chorus creates a "floating" sound typically associated with guitars and synth 
pads. It can acoustically "thicken" an instrument, making it sound fuller or 
creating the illusion that several instruments are playing.  

 

Speed: Modulation speed. Low speeds create an even, continuous 
development. High speeds produce vibrato-like qualities but can also result in 
an ‘under-water’ effect. 

Depth: Modulation depth. This determines how strongly the speed affects the 
pitch modulation.  

Mix: This sets the balance between the direct signal and the effects signal.  

Mode:  
 "Normal" is a combination of the direct signal and the detuned delay signal.  
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 "Normal, low cut" is designed for bass-heavy signals such as bass guitar. The 
bottom end of the signal stays clear and well-defined, the effect is only 
audible for the mid and treble frequencies.  

 "Dual" makes the source sound more lively than a single ‘part’. The sound is 
spread over the stereo panorama, which makes this mode seem ‘wider’.  

 "Quad, low cut" is ideal for creating sounds such as deep synth pads with 
tight bass frequencies. 

Tip: Like on the stomp boxes our vintage effects are modeled on, there is a 
‘footswitch’ below the pedal’s logo that can be clicked to turn the effect on or 
off for A/B comparisons. All the effects of the Vintage Effects Suite have been 
designed like this. 

Distortion 

  

The distortion pedal is a “high gain” distorter for crunch and lead guitar 
sounds. If you like typically “British” amp sounds and want to quickly record a 
guitar track with little effort, this pedal is for you. 

An entire valve pre-amp circuit has been modeled, including the typical EQ 
curve. The amplification is “valve-typical”, i.e. it doesn’t start quickly but is 
harmonic and soft. Even at full power the pedal still reacts softly to a guitar 
and its settings (e.g. pick-up choice and tone controller). For instance, you 
can influence the distortion even more by using the volume knob on the guitar. 

There are only three parameters on this effect; however, these interact with 
each other and can thus generate quite a variable sound: 

 Low: the “bass” controller. This allows you to set the share of basses, even 
after the distortion. The type of prefiltering is important for guitar amps in 
particular, and is characteristic for the basic sound. You should set the bass 
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controller depending on the basic sound of the guitar and the sound you are 
aiming for (“powerful” or “cutting”). 

 High: Mainly controls the share of highs before and after the distortion. If you 
are not using an external guitar speaker as a monitor, we recommend setting 
the controller to the middle position or even moving it slightly to the right. This 
way the “sharp” highs disappear, which all guitar amps generate without the 
suitable loudspeaker. At the same time the mids stand out more, which gives 
the sound more “kick”. On the other hand you can further emphasize the 
highs if you want the sound to be more neutral. 

 Drive: The level of distortion. This controls the amplification used to operate 
the “virtual valve circuit” (max. 60dB). As the level increases, the valve goes 
into overdrive and generates typical distortions. For a slightly distorted sound 
(“Crunch”) it is surely sufficient to set the controller to 10-11 hours at 
maximum. Furthermore the modeled circuit provides the usual “weight” for 
power rock chords and more. The further you turn this controller to the right, 
the more the mids of the signalmove to the fore so that the “high-gain” lead 
sound is better heard. 

Voice over 

The "Voice over" effect creates a volume curve for automatically fading 
background music during spoken sections. To do this, proceed as follows: 

1. Record speech. 
2. Load your background music. 
3. Move the object containing the background music to the second track 

below the spoken portion. Note: The second track can be opened with the 
"2" key. 

4. Place your speech recording at the correct position, then cut and edit it 
with the object handles to remove undesired noise or mistakes. 

5. Now open the voiceover dialog via "Edit" and activate the voiceover effect. 
6. A volume curve (view page 39) is created on the second track which 

automatically fades the background music at the correct positions. 
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Use the faders to set by how much the volume of the background music 
should be reduced during speech passages and how quickly this should 
happen.  

Use the selection list to apply the curve to the first track as well, should you 
have placed your background music there. 

If you later want to move or shorten your voice recordings, click on the 
"Update" button to adjust the volume curve. 
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Export 

 

In the export section, you can either save the project as audio file(s) or burn it 
directly to an audio CD or DVD. 

MP3 files 

 

Use the button "MP3 files" to export 
individual tracks into MP3 format. 

This is a quick access option to the Export project dialog (accessible via "WAV 
and other file formats" (view page 118)), where all necessary settings for MP3 
export have been defined already. 

MAGIX Audio Cleaning Lab MX contains a high-quality and extremely fast MP3 
encoder. Use it to quickly save complete LPs along with the cleaning effects 
as MP3 files. You can now use them on MP3 CDs, for instance. To do so, use 
the function "Burn data CD/DVD" (view page 120). 

For good quality, we recommend a setting of at least 160 kbit high quality. 
Sound quality will hardly be affected despite the compression. If you have 
memory to spare, full CD quality can be retained at 256 kbit high quality – at 
approximately 1/5th of the original memory. This is ideal for building up a large 
high-quality music archive on your PC's hard disk. 

Note: For exporting as MP3 format, you may need to activate your MP3 
encoder first. Simply go to "Help" >"Activate additional functions" (view page 
160). 

Format settings 

Output format: Set the output bit rate and the stereo or mono format here.Bit 
rate is the data stream during playback of audio or video data. It is given in 
kilobyte per second (kbit/s or kbps) and also determined the file size. An MP3 
file that is 3 minutes long and has a constant bit rate of 128 kbit/s is ca. 2.8 
MB in size. 
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Bit rates for music are usually 192 kbit for good quality, 256 kbit and more for 
excellent quality. 128 kbit are sufficient for Internet streaming and speech (in 
mono). 

Encoder quality: The included MP3 encoder can operate in three "gears": 
"Fast" mode is especially fast, "highest" mode is very powerful to achieve the 
best sound possible and takes a little more time, and the third "gear" is a 
compromise between the two. 

Padding options: Leave this setting on ISO padding, unless you detect 
undesired pauses at the beginning of tracks during playback on certain 
players. 

Encoder settings: These are optimizations that will only be used for low bit 
rates (smaller than 128 kbit) to reduce the file size. "Permit intensity stereo 
coding" or "mid/size stereo coding" will save certain parts of the audio 
material in mono to save bandwidth. The extend to which sound quality is 
improved depends on the material. "Permit mixdown in mono" allows the 
encoder to save in mono if it detects that the content of both stereo channels 
is identical, even if stereo was set as output format (e.g. introduction within a 
radio program). 

Content options: The "Use CRC check" option adds an internal checksum to 
the MP3 file which checks whether the MP3 file is complete. The other options 
(private, copyright, original) are merely for your own labeling system, as they 
won't be evaluated in any form. 

VBR: VBR (variable bit rate) adjusts the bit rate to the audio material, so a 
lower bit rate will be used for quiet parts. Therefore, VBR files are smaller than 
files of comparable quality without VBR. Thus, a constant bit rate setting 
doesn't exist, but rather a quality setting. Not all playback programs and 
devices can use VBR properly; problems may occur when displaying the track 
length and during winding (seeking). 

Audio CD 

Open the burn dialog of MAGIX Audio Cleaning Lab MX via the 
"Audio CD" button in the export section. Burn any project in 
MAGIX Audio Cleaning Lab MX to an audio CD one-to-one. 

For basic information about this, please read the section entitled "Burning 
audio CDs" (view page 116)! 
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Make CD/DVD dialog 

Burn CD "On the fly", all effects are calculated in real time: This option 
instantly starts the writing process if a new recordable CD is located in your 
CD-R-drive.  

Create image file before burning Audio CD: This option will first create a 
stereo file, which already contains all object-settings, cleaning- and mastering 
functions, track-markers etc. before the writing process starts. This is 
recommended, when the system is too busy or too slow for creating a CD in 
real time ("On the fly"). Have a look on the System-information in the main 
menu! Multiply the displayed value with the intended burning speed (e.g 4x, 
8x..). If the product is coming critically close to the 100%-mark, then we 
recommend you to create an image file before burning the new CD. 

For example, when you want to burn an Audio CD with 8x speed, the CPU 
display shouldn't go over 12% 

After image creation, the image is instantly burned in CD and deleted again 
after successful burning. 

Burn MP3 CD/DVD: Burn a Data CD (view page 120) or DVD with MP3 files 
The "Format Options" button takes you to the MP3 encoder settings. 

CD Title: Type in a name for your new CD. The project name is preset. This 
title can be displayed by some of the CD-players if your CD-writer supports 
the CD Text function. (The supported CD-writer functions can be seen if you 
use the Display CDR-Drive Information option). If the writer supports CD Text, 
the track names will also be transferred to the new CD. 

Track list: Option that allows you to control the track list (view page 146) – 
also accessible via the CD menu. All tracks can be played and markers can be 
shifted. 

freeDB CDinfo: Query title information from freeDB internet database (view 
page 147).  

Burn CD: opens the burning dialog from where you can select the burning 
speed, the CD text to be burned on the CD, simulation of the burning process 
as well to assign the CD as a CD Extra Project. You can also compare the CD 
after burning with the project data to determine the error rate. If it is too high, 
the burning speed must be slowed down.  

Cancel: closes the "Make CD/DVD" dialog without creating a disc. 

Keyboard shortcut:  b 
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Track marker assistant 

The automatic track marker assistant searches through the material for 
pauses in order to place a track marker at the end of a pause. 

Each track marker is then displayed in a list where it can be easily and clearly 
checked, moved or deleted. 

Track marker recognition is recommended if, for example, a side of an LP was 
recorded without track markers and the track markers then have to be set in 
order to be able to burn an audio CD. You can also use track marker 
recognition to check automatically created track markers afterwards. 

Play: plays or stops the tracks in the list that are highlighted in gray, that is, 
that are selected. To select a different track, simply click on it in the list. 

Next track: selects the next entry. 

Move: You can move the beginning of the selected tracks forwards or 
backwards using the two arrow buttons. 

Keep marker: Here you can remove the track marker of a selected track 
should it be superfluous. To do so, you will have to deactivate the check box 
for the selected track (is also possible in the list on the far left). Then, the 
marker is removed, so that the track is attached to the previous one. 

OK: closes the list of available tracks. To make sure, the program asks you 
once again whether the settings you have chosen should be applied to the 
audio material on the track or discarded. If you choose "Apply", the track 
markers in the track window will be set according to the settings. 

CD assistant 

The CD assistant helps creating an audio CD and positioning the track 
markers. 

If a blank CD is in the CD burner, the CD assistant compares the length of the 
project with the capacity of the blank CD. If the project is too long for the CD, 
an error message is displayed. 

As a second step the burn assistant checks the track markers by playing back 
the beginnings of the tracks one after the other. If you notice that track 
markers are positioned incorrectly, you can place new track markers via the 
burn assistant, or move existing track markers. 

As a third step, the burn assistant checks the occupancy rate of your PC and 
calculates the write speed that is best suited. 



 

 116 Export  

www.magix.com

Finally, either the CD is burned directly or an audio file is generated which then 
can be burnt at maximum speed. 

Make audio CDs 

Basics 

In order to unify the data structure of the CDs and to facilitate the use of the 
CD-drives, different standards were created for the different types of CDs. The 
names for these standards refer to the colour of the books in which these 
standards were written down. Apart from the Red Book standard for audio 
CDs, there exists for example a Yellow Book standard for CD-ROMs and a 
White Book standard for video CDs in MPEG format. The term "Red Book" 
stands for "Compact Disc Digital Audio Standard".  

The Red Book standard includes the Sampling rate of 44,1 kHz and the 
16-Bit-resolution, which is supported by the commercial CD-Players and is 
also valid for the audio CDs. Furthermore the audio CDs have to count 1-99 
tracks, which can be directly selected by the CD-players. The information 
concerning number and duration of the tracks as well as the breaks are 
transmitted from the CD to the CD-player through special sub-channels.  

Data transfer 

Writing a CD is especially demanding when transferring data from the hard 
disk to the CD-writer. The data has to reach the CD-writer in a constant flow. 
If at any time during writing the cache of the recorder runs out of data, the 
"Buffer Underrun"- error message will appear. This will make the CD useless. 
For this reason, it is recommendable to use modern SCSI- or IDE-hard drives. 
The average access time should be 15ms or faster and the steady 
Data-transfer rate should not be less than 800 Kbytes per second. This is the 
case for all modern hard disk drives. 

The Burning Function 

The audio material on the audio CD is digital data, which the CD-player reads 
and transforms into analogue signals. The track markers indicate the 
CD-player, at which point the song starts. The MAGIX Audio Cleaning Lab MX 
can write an audio CD right away from the program. The track-markers are set 
in the track window before writing the CD. MAGIX Audio Cleaning Lab MX 
transforms the stereo sum and the indices into a data flow, which is directed 
to the CD-writer. 

The CD-R-drive modifies a specially designed layer on the medium using a 
laser, so that the audio CD-player will be able to read this information later as 
digital audio data. 

Audio CD creation 
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1. For writing an audio CD, the track window must contain audio material. 
Edit the audio material using the real time functions of the MAGIX Audio 
Cleaning Lab MX deLuxe. The CD will sound exactly like the playback 
when you listen to it through your stereo sound card. All Cleaning and 
Mastering effects will also be present on the CD. 

2. Mark the starting position of each song by setting (or moving) the track 
markers. All track markers can be moved using the mouse or the Track 
Wizard (1Click button) 

3. Click on the "Make CD" button. In the "Make CD" dialogue you can 
choose, if you want to write the CD directly or if you prefer to create an 
Image file on the hard disk. The creation of an Image file is then 
recommendable, when the available system resources are not enough for 
writing the CD in real time ("On the Fly"). 

4. Now the CD can be written. You will only need a CD-R-drive, which is 
supported by MAGIX Audio Cleaning Lab MX connected to your computer 
and an empty CD in the drive. Clicking on "Write CD" starts the writing 
process. If you should have more than one CD-R-drive connected to your 
system, you will be prompted to select one of them. 

Track Length 

According to the RedBook Standard, the minimum distance between two 
Track Markers is 4 seconds. Since Track Markers normally show the 
beginning of a song, no problems should arise. If you try to set the MAGIX 
Track Markers at a lesser distance, an error message will appear. 

System display 

 

The system resources are very important while writing a CD in real time. Once 
the process has been started, it cannot be interrupted. When writing "on the 
fly", the computer has to calculate the playback including all real time 
functions and write them on the CD at the same time. If the system is not fast 
enough, the process will be aborted and the CD will be useless. 

The system display of the MAGIX Audio Cleaning Lab 11 helps you to prevent 
such problems when writing a CD. 

If your system is overcharged, activate the "Create an Image file" option in the 
"Make CD" dialogue. This will create a stereo file, which will be the source for 
the writing process. This file includes all effects and object settings, as well as 
the tracks and track markers, so that the system doesn't need to calculate 
them again while writing various copies (see Write CD parameters (view page 
114)). 
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CD tracks als separate wave files 

In order to burn more CDs later, without having to produce a new image file, 
you can export all CD tracks as single .wav files. Select the option, "Each CD 
track in a file", in the Export dialog. Later, you can load the tracks and burn 
them directly. Exporting will make a play list file with the "m3u" extension. If, 
instead of opening each wave file, you open the Playlist File, all project tracks 
will be loaded in the right order, and the standard pause of two seconds will 
be inserted between songs. All effect editing is included in the wav files, so 
you can burn additional CD copies  "on the fly". 

Checking Audio CDs 

In the burn dialog it is advisable to activate the "Test and compare CD after 
burning" option in order to examine the error rate. If it is too high, the burning 
speed must be slowed down. 

Export audio 

 

Via "Files" you can save the tracks from the 
current project as audio file(s) in different 
formats.  

The "Export project" dialog will open. Here you can specify file name and path 
as well as the file's format. 

Options 
All tracks in one file: Saves the project, named after the project name, in one 
audio file. 

Track only at playback position: Saves the track that is currently placed at 
the playback position, namely the project area between the last track marker 
before the position line and the following track marker. This way you can cut 
out parts of an audio file and save them separately by simply placing markers. 

Each track in its own file with names: Exports each track (i.e. the area 
between one track marker and the next) into a separate audio file list. If the 
tracks are saved individually, then a file (.m3u) will be created which contains 
the names of the individual audio files in the correct order. This is practical 
since you can open the list file again and load all of the tracks that belong to 
the project in the right order all in one go. The list file contains the name of the 
project; the list field allows different naming schemes for the audio files. 
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Scheme Example 
(File name)_(Track number) CD_1.wav, CD_2.wav ,CD_3.wav 
(Track name) AAA.wav, BBB.wav, CCC.wav 
(Track number) (Track name) 1 AAA.wav, 2 BBB.wav, 3 CCC.wav 

File names for a project "CD.vip" with the tracks AAA, BBB, CCC 

Format settings: This button opens another dialog where you can set export 
formats and adjust their settings. With compression formats like MP3 or OGG 
you can select codec compression rates. 

Wave: The audio material is exported as a standard Wave file. This is the 
conventional format for further use on Windows PCs. These files are not 
compressed and retain their full sound quality. 

FLAC: FLAC is the abbreviation for "Free Lossless Audio Codec". This is a 
freely savable format that can be used to compress your audio data to 50% of 
their original size. Unlike lossy compression methods like MP3 or OGG, the full 
sound quality is kept intact with FLAC. 

MP3: Use the MP 3 files (view page 112) button to quickly access the export 
in MP3 format option. 

AAC: This is a modern competitor format to MP3, which is primarily used for 
portable music players (iPod, etc.). 

Note: To export in MP3 or ACC format, you may need to activate your 
encoder first. Simply go to "Help" >Activate additional functions (view page 
160). 

OGG:OGG Vorbis files have all of the important characteristics of MP3 files, 
except that they do not require any kind of licensing for their codecs. – They 
can be freely decoded and encoded. Not all portable devices support this 
format. 

AIFF: The audio material is exported as an AIFF file. This is the most 
commonly used audio format for Apple™ computers. 

Windows Media: Exports the arrangement in WMA format (Windows Media 
Audio). These are streaming audio files which are used on the Internet to 
guarantee real-time audio streaming. The sound quality is slightly diminished, 
but the files are extremely small. 

Keyboard shortcut:  K 
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Create audio DVD 

MAGIX Audio Cleaning Lab MX also burns DVDs, and there are essentially two 
different types of DVD that are possible:  

Stereo DVD: These are normal video DVDs that can be 
played on any DVD player. Since they don't contain any 
video data, there is more room for the audio data. This can 
be stored either in CD quality with 16 resolution or in 
high-resolution 24 bit audio.  

Surround information is encoded as two-channel stereo audio (Dolby 
Surround ProLogic compatible) 

4 channel DVDs: These are so-called "audio DVDs" and 
require a special DVD player for playback. Music is 
recorded in true 4-channel Surround sound for these 
devices, and 16 or 24 bit resolution is also available in this 
case. 

Burning 24 bit DVDs is only sensible, if the original audio material was also 
recorded in 24 bit quality. 

Depending upon the format, different project lengths are possible. 

DVD video 16 bit: 6h 33 min 
 24 bit: 4h 23 min 
DVD audio 16 bit: 3h 36 min 
 24 bit: 2h 24 min 

 

   

Data disc 

 

This option opens the CD burn dialog with the 
preset option "Burn MP3 CD/DVD". This option 
allows the project to be burned onto a data CD or 
DVD as MP3, OGG VORBIS or WMA format.  

You can change the format settings of the respective encoder in the dialog. 

If your project already contains files in compressed formats, then you have the 
choice to encode these files again or to use the original files. In this case, 
these files will lose all editing and effects changes which you have made. 
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Batch conversion 

Batch processing lets you automate work processes. You can extend a 
specific editing process from a single audio file to a list of files any size (i.e. the 
"batch"). The files are then executed automatically, over night, all day, or 
however you like. 

Possible jobs may include: 

 Normalization, volume adjustment, loudness 
 Linear fading (in and out) 
 All real-time cleaning and mastering effects 
 Removing direct current 
 Resampling/Timestretching (view page 106) 
 Format conversions: Bit width (8/16/24-bit), sample rate, 

stereo/mono/left/right 
 Save in all available export formats. 

Examples of use: 

 Encoding a large number of wave files into MP3 while simultaneously 
adjusting volume and freshening up higher frequencies 

 Loss-free conversion of wave files into FLAC to save up to 50% hard drive 
space 

 Correcting multiple LP recordings with incorrect speeds 
 Denoising original sound tracks 

The process for batch conversion is as follows: 

1. In the "Source file" tab, select the files for editing. 
2. In the "Effects" tab, select the required editing processes. 
3. In the "Time format" tab, select the output format. 
4. In the "Target files" tab, specify where and under what names the files 

should be saved. 
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Source files 

 

 Drive 

 Path 

 Superior folder level 

 Refresh 

 File browser 

 Add to editing list 

 Editing list 

 Preview 

 File filter 

 Start editing 

Create the list of files you want to edit. You will find a file browser on the right 
side. Select the files you would like to edit by clicking them; multiple selection 
is also possible (Ctrl + click for individual files, Shift + click for series, Ctrl + A 
to select everything). The view can be limited to certain audio formats via the 
file filter at the bottom. Every audio file can be pre-listened with the preview 
button. 

The "Add" button in the middle inserts all of the selected files into the editing 
list. If a folder has been selected, then all audio files in the folder, including all 
subfolders, will be added to the list. 

 
Loads a list (*.m3u format). 

 
Saves the list in *.m3u format for using your selection of files later.  
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"Remove" deletes all selected list entries. "Remove all" deletes the complete 
list. 

Effects 

 

Amplitude 

No changes: The amplitude remains unchanged. 

Normalize/change level to: You can normalize to a specific maximum value in 
%/dB or sink/raise the level by a certain value. Read more about this in the 
section "Edit menu -> Normalize object volume (view page 139)". 

Adjust loudness: Loudness adjustment ensures a balanced average volume 
for each audio file. Read more about this in the section "Edit menu -> Adjust 
loudness". 

Fades at project start and end 

Linear fades of any length can be added to the beginning and/or end of files. 

Effects 

No effects: No effects editing takes place. 

Current settings/effects presets: This section allows all cleaning and 
mastering effects in MAGIX Audio Cleaning Lab MX to be used for batch 
conversion (including plug-ins). The batch processing dialog does not in fact 
offer direct access to the extensive settings options for the individual effects; 
instead, there are two choices: 
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 "Current settings": All effects settings in the currently loaded project will be 
applied (except object effects). First you can load one of the edited files into a 
new MAGIX Audio Cleaning Lab MX project and make the required effects 
settings in real time there. Then you can open batch conversion and apply 
these settings to all of the other files. 

 "Effects presets": You can select the cleaning or mastering effects presets 
included with the program or the ones you created yourself. 

Remove direct current: Remove direct current noise from analog recordings; 
see "Remove direct current (view page 80)" in the "Edit" menu. 

Resampling/Timestretching: Changes the playback tempo; see 
"Resampling/Timestretching (view page 106)" in the "Edit" menu. 

Target format 

File format: All export formats available in MAGIX Audio Cleaning Lab MX are 
available here with their associated format options. 

Stereo/Mono: You can convert in stereo (mono sources feature the same 
signal on both channels), save one of the stereo channels as a mono file, or 
mix both stereo channels together to create a mono file. 

Bit resolution/sample rate: The bit resolution can be changed to 8/16/24-bit, 
and the sample rate to 11,025, 22,050, 32,000, 44,100, or 48,000 Hz. 

No changes: This means that the output format is applied unchanged. 

Destination files 

There are several ways to save edited files: 

Replace source files: The original files are replaced by the edited files. If the 
file is used in a project, then the project will be closed first. 

Save files in source directory with changed name/save files in following 
directory: The edited file is saved in the source directory or in any chosen 
directory. The specified suffix/prefix is added to the file name. Optionally, you 
can delete the source files after editing them. 

Keep source directory structure: This option saves all files including the 
source path. The folder structure is preserved if the source files originated 
from different folders. 
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File Menu 

New Project 

Using this option you can set up a new MAGIX Audio Cleaning Lab MX project 
(view page 59). 

Keyboard shortcut:  E 

Load project 

Using this option you can load previously saved projects (view page 59).  

Keyboard shortcut:  O 

Save Project 

The current project (view page 59) is stored under its given name. If there is 
no name chosen, the program opens a file requester, where the path and 
name can be determined. 

Keyboard shortcut:  S 

Save project as 

It opens a file requester where you can determine the path and the name of 
the project (view page 59), under which it will be stored. 

Keyboard shortcut:  Shift + S 

Burn project backup onto CD/DVD / Burn data 
CD/DVD 

In addition to the integrated audio CD burner routines, MAGIX Audio Cleaning 
Lab MX contains the CD burning program MAGIX Speed burnR. It can help 
you burn data CDs/DVDs, too. 

Burn project backup on CD/DVD: The current project (including all audio files) 
can be burned directly to CD or DVD as a backup directly from the "File" 
menu in MAGIX Audio Cleaning Lab MX. Even extremely large files do not 
present a problem, since they are automatically distributed across several 
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dics. The first of the backup discs contains a "Restore" program. This 
automatically begins the restore process to the hard disk as soon as it is 
placed in the drive. 

Burn data CD/DVD: This command opens the MAGIX Speed burnR program 
with an empty burn queue for burning desired files to disc. 

Load audio file 

 

MAGIX Audio Cleaning Lab MX can import audio files in 
the formats WAV, quicktime (*.aif), Ogg Vorbis (*.ogg), 
MP3, WMA and AVI (soundtrack only).  

To do this, click on the corresponding button of the Import section (Import 
Audio), which opens the "Load audio file" dialog. Here you can select any 
folder containing audio files. Every listed file can be previewed and loaded into 
MAGIX Audio Cleaning Lab MX. 

The selected file is attached behind the last following a pause of 2 seconds. 

You can also load several files simultaneously. Just like in the Windows 
Explorer, you can increase your selection with Ctrl+Click and select a range of 
files with Shift+Click. 

Hint: Due to peculiarities of the Windows Explorer, the line in the file selection 
dialog is created from back to front. Therefore, if you click it subsequently, you 
will see "Track 3", "Track 2" and "Track 1" in the input line. This is also the 
order in which the tracks will be loaded into MAGIX Audio Cleaning Lab MX. 
Therefore, if you want to load several titles, you should select them in the 
opposite order of how you want them to be later.  

However, if you want to select a range in the Explorer (with Shift+Click), you 
should proceed as follows: first mark the last track of the list, then press Shift 
and mark the first track of the list. If you now click on "Open", all tracks are in 
the VIP in the correct order. 

Keyboard shortcut: W 
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Load audio CD 

You can import entire Audio CDs or individual CD tracks into the project. 
Unlike data CDs, audio CDs require special treatment while importing 
("grabbing" or "ripping"). The data is imported digitally, thus eliminating loss in 
sound quality.  

To import audio tracks you should proceed as follows: 

1. Insert an audio CD into the drive and click on "Import CD". A dialog with a 
list of the CD tracks will open. If you have more than one drive, you may 
have to first select the drive containing the CD. You can do this in CD drive 
options. 

2. Select the desired tracks (multiple selection by Ctrl + mouse-click). 
3. Click on "Copy selected track(s)." 
4. The "Import project" dialog will now appear. Here you can enter the file 

name and select the target directory.  
5. The audio material is then copied from the drive onto the hard disk. A 

progress bar is displayed. 

Once ripping is complete, the dialogs will be closed and the tracks are 
inserted into the project as individual objects. 

Keyboard shortcut: D 

Import DVD audio 

This command imports the audio contents of a DVD into MAGIX Audio 
Cleaning Lab MX. 

Note: Importing the audio track(s) from a video DVD is not possible! 

Record 

With this command you can open the MAGIX Audio Cleaning Lab MX record 
dialog. More information on this topic can be found in the chapter Record 
audio (view page 47). 

Keyboard shortcut:  R 
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Export audio 

Read the section "Exporting audio" in the "Export section" chapter. 

Batch conversion 

Opens batch processing to automatically edit multiple files. Read more about 
this in the separate chapter "Batch processing (view page 120)". 

Keyboard shortcut:  Shift + B 

Load video sound 

MAGIX Audio Cleaning Lab MX gives you the option of editing the audio tracks 
of video files like audio files. The file selection dialog contains a video preview 
window for this purpose. 

Permitted import formats are: QuickTime (*.mov), MPEG (*.mpg;*.mp2), AVI 
(*.avi), and Windows Media (*.wmv) 

After the video audio track has been loaded, a video window opens playing 
back the image and audio tracks of the video synchronously. Show and hide 
the video window via the "Options" menu. 

Keyboard shortcut:  j 

Export video sound 

After editing the audio track of AVI video files, you can write it back into the 
video file. 

Video source: This is where the loaded video file is usually displayed (only with 
AVI files, see below). If you wish to write the audio track back into a different 
video file, you can choose it here via the folder symbol. 

Audio length: Displays the length of the audio track and video audio track. 
Their lengths should be identical. 

Audio format: The audio track is always written as a WAV file, compressed 
storage formats, such as AC3 or MP2, are not possible. You can change the 
compression format of WAV files here provided that the corresponding 



 

File Menu 129  

 

www.magix.com

compression codecs (ACM codecs) are installed. They must also be available 
on the computer used for playback of the finished video. 

Target file:You can either replace the sound of the video in the original video 
file or create a new AVI video file. You don't have to recompress the video 
data, which is very time consuming, because the existing video data is 
connected to the new audio data. 

Warning: The option of replacing the audio track in the loaded video or writing 
a new video file with new sound only works with AVI videos. Other video 
formats (MPEG, MOV, WMV) require a video editing program, such as MAGIX 
Movie Edit Pro, to save the new audio track in the video. 

Keyboard shortcut:  g 

Internet 

This is a list of menu entries regarding all of the services that are available 
directly from within MAGIX Audio Cleaning Lab MX. 

MAGIX Online Album 

In the MAGIX Online Album, you can post your favorite photos online and then 
send the link to your friends. All photos are immediately available from 
anywhere in the world on a professionally-designed photo website, in 
well-organized photo galleries, as full-screen slideshows, or in the form of a 
personal photo e-card.   

 Personalized photo website in many designs.   
 Unique Internet address (URL). 
 Upload your pictures directly from a camera phone, send the link, and share 

the picture with other camera phone users. 
 Full-screen online slideshows with fade effects and music. 
 Send custom designed e-cards with your own photos. 
 Share your photos with friends, including Internet management and password 

access to private albums. 

Your photos online 

MAGIX Online Album is available in three versions, of which the smallest (the 
FREE album with 500MB webspace for your photos) is entirely free.   

The larger versions (CLASSIC or PREMIUM) are available for a monthly 
charge, but also come with many handy features, such as a faster website, 
2,000 MB or 5,000 MB storage space, more website designs or access by 
mobile phone/PDA. 
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More information about prices and included services is available at 
www.magix-photos.com. 

Just three easy steps: Within minutes your first pictures will appear on the 
Internet: 

1. Select photos 

Choose your favorite photos directly from the program and optimize them in 
just a few clicks. Put completed photo albums together and integrate music of 
your choice. 

Do it all offline on your PC - saves you money! Then select "Services" from the 
program's menu bar "MAGIX Online Print Service -> Send selected".   

2. Upload photos 

In order to upload photos to your MAGIX Online Album simply log in using 
your email address. Naturally, access is protected via your personal 
password. 

If you still don't have access, click on Register now! to activate your own 
album in just a few minutes. Then off you go! 

3. Done! Your own personal photo website is finished 

and your best photo memories are on the net. As a photo gallery or fully 
automatic slideshow (fullscreen).   

Now, invite all your friends with just one click or show your photos on the road 
using your WAP-compatible camera phone. 

Using your MAGIX Online Media Manager, you can quickly manage your 
photo website, upload photos and music, create new albums, add designs 
and text, and much more. All online without even having to download any 
extra software! Worldwide, easy, and quick in just a few clicks. At 
http://www.magix-photos.com 

The following options are also available: 

Send e-cards and photo emails 

Send your photos as unique e-cards with great designs, or as a photo email 
to your friends and acquaintances. 
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Order photo prints and gifts 

Order paper prints or great photo gifts from your MAGIX Online Album and 
have them delivered directly to your home, or pick them up from a photo lab in 
your area. Delivery time is usually just 2 - 3 days. 

Upload current arrangement as MP3... 

Converts your arrangement's audio track into an MP3 file and uploads it to 
your personal MAGIX Online Album. 

Download media 

This command loads files from MAGIX Online Album to your PC.  

Open my online album... 

This command opens your own MAGIX Online website. You must login and 
enter the page's Internet address (URL) to continue.  

MAGIX Website Maker 

Not only is Internet surfing easy! Thanks to MAGIX Website Maker creating 
websites also becomes child's play! 

This service offers: 

 Your desired domain (www.desiredname.com) and a subdomain  
(http://your-name.magix.net/website). 

 250 MB memory space with 5 email accounts, 1 GB each. 
 Website Maker with website templates, intros. Also animations, text effects, 

form and design objects, picture and graphic templates, and buttons. And 
everything without any ad banners! 

 Photo (*.jpeg), video (*.wmv) & music (*.mp3) options. 
 Additional software: MAGIX web mail for managing your email inbox.  

MAGIX Website Maker offers 3 months of free, non-binding service. This way, 
you have enough time to find out everything about MAGIX Website Maker and 
all existing possibilities for editing and managing your homepage. 
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MAGIX Website Maker offers everything for the perfect Flash website: 

 Design templates: Numerous high-quality website templates in the latest 
professional Flash® design with pre-finished, customizable subpages, start 
pages, profile pages, photo pages, video pages, and much more.  

 Text & text effects: Freely positionable text fields with fantastic fonts and 
animated text effects can be added and individually formatted with ease.  

 Multimedia content: Select your favorite photos, spectacular slideshows, 
videos and an online video player with your own background music, or 
integrate it all as an online music player with playlists. 

 Decorative elements: Attractive design objects, plenty of vector shapes, 
background images, buttons, and much more offer more possibilities for 
designing unique websites than ever. 

 Animation objects: Large selection of dynamic, impressive animation objects 
for breathtaking, moving websites. 

 Links: Easily add links to your own or external websites.  
 Top extras: Enhance your website with a visitor counter, guest book, contact 

form, and many other useful extras. 
Export function: Conveniently add individual components of your website 
(e.g. video player, slideshow, online music player) or even the entire website 
to external sites as an embedded website. 

Proceed as follows: 

After registering your desired domain, you can start creating your website right 
away. 

1. First, select a design for your website in MAGIX Website Maker 
2. If you would like to place an intro (start animation) at the start of your 

domain, select your intro as a next step. 
3. Now you can replace the mock text with your own text as you see fit. All 

free-standing elements on all webpages can also be moved as you please. 
To do so, click to select the element and move it using your mouse. 

4. Once everything is just how you want it, you can put your page online, so 
that your domain can be accessed.  

Catooh – the Online Content Library 

Catooh provides you with high-quality photos, videos, and music for every 
theme, expanded by intelligent iContent with professional Soundpools, DVD 
menu templates, and brilliant MAGIX ShowMaker styles to help you make your 
photo, video, and music projects reality. All of this is available directly from 
your MAGIX software. 

Just choose "Share" from the menu "Catooh" to set up an Internet 
connection. 
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Browse through the thematically sorted categories or view the results directly 
by entering a keyword. After downloading, you can drag the objects from the 
Media Pool directly into your arrangement. 

Tip: Read the introduction online http://rdir.magix.net/?page=JRF6LASAR2Z3! 

Import media backup 

iContent (for example, 3D transitions) which you buy and download from 
Catooh is stored directly in your central My files\MAGIX Downloads\Backup 
directory. If you have downloaded these files from other MAGIX programs, 
then you can use the command "Import media backup" to make them 
accessible for use in MAGIX Audio Cleaning Lab MX. 

Find media 

Opens Catooh and loads your files directly into the arrangement.  

Keyboard shortcut:  O 

Manage login details 

These are options for managing user names (email addresses) and the 
associated passwords so that you are able to access your Online Services 
without having to enter the details each time. 

This information applies to all of my Online Services: If this option is 
activated, then the account details you have entered will be applied to all 
Online Services. Deactivate this option if you have different details for 
individual services, then choose the corresponding service via "Select service 
and enter the associated login details.  

Delete old projects 

The command "Delete old projects" is a convenient method for deleting old 
projects with all affiliated audio files. 

Project: All of your most recently saved projects as well as all projects 
contained in the Project folder (view page 156) are listed here. You can 
choose one that should be deleted. Use "Search for project" to add other 
project files from any folder to the list. 

Select the project file (.vip) that should be deleted by clicking on it. Of course, 
a project can not be opened if it is to be deleted. 

The "Open in Windows Explorer" option opens an explorer window with the 
folder of the selected project. Here you can...no longer required files manually. 

http://rdir.magix.net/?page=JRF6LASAR2Z3�
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Used files: Lists the files used in the project that you want to delete. Use the 
small boxes to select the files you wish to delete.  

With "Delete" you can delete the project (.vip) and the files selected for 
deleting in the file list. 

When you select a project you wish to delete, some files in the list, i.e. files 
located in the project folder are selected already. They are recording files, files 
that are automatically produced when importing specific formats, and back up 
copies. In other words, data which is used only within one project of MAGIX 
Audio Cleaning Lab MX. 

Files which are not located in the project folder, MP3 files from music 
collections or videos, for instance, are not selected, as you will probably use 
them in other projects or with other programs. You can select them if you're 
sure you don't need them anymore. In general, it's quite sensible to have the 
preset apply to the project folder because it allows you to simply choose a 
project at the top and to click "Delete" at the bottom to delete files which are 
no longer needed in a project. 

Exit 

Closes MAGIX Audio Cleaning Lab MX. 
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Edit Menu 

undo 

In the project you can undo the last changes you made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
you can always revert to the previous state using "Undo". 

Keyboard shortcut:  Ctrl + Z 

Restore 

The “Redo” function undoes the previous “Undo” function. 

Keyboard shortcut:  Shift + Y 

Undo Lists 

The last 20 editing steps are listed. You can return to a precise editing step 
without complication. 

Set marker 

With this command you set a marker into the track to mark a certain time 
position in the project. You can jump between the markers with the keyboard 
commands Alt+Arrow left/right. 

Keyboard shortcut  Alt+M 

Split 

A selected object is split into two objects at the position line. This also works 
during playback. 

Keyboard shortcut:  T 
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Remove object beginning 

This command removes the part of an object beneath the position line, 
chronologically located before the position line. The audio material following it 
is moved forward to the initial position. 

Keyboard shortcut:  D 

Remove object end 

This command removes the part of an object beneath the position line, 
chronologically located after the position line. The audio material following it is 
moved closer. 

Keyboard shortcut:  U 

Cut 

The selected object is cut out from the project and placed on the clipboard. It 
can then be reinserted elsewhere. 

Keyboard shortcut:  Shift + Del 

Copy 

The selected object is copied from the project into the clipboard. It can then 
be re-inserted elsewhere. 

Keyboard shortcut:  C 

Paste 

The content of the clipboard is inserted into the project at the position line.  

Keyboard shortcut:  Ctrl + V 

Delete 

The currently selected object will then be deleted from current project. The 
subsequent objects are moved forward so that there is no gap in the track.  

Keyboard shortcut:  Del 
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Remove pauses 

 

This function automatically removes sections without or with low audio level in 
the selected object. In the dialog, you can set a minimum time and threshold 
for recognition. 

Threshold (dB): Here you can specify the threshold. The value is specified in 
decibels, 0db corresponds to the maximum level. Typically, you will enter 
negative values, the higher the numerical value, the lower the level and the 
less audio material is removed. 

Min. Time (ms): Here you can specify the minimum time for recognition. If the 
function removes intended (musical) pauses in the music, increase the value. 

Apply to all objects: If this option is activated, the function will be applied to 
all audio objects in the project. 

Voice-Over 

More on this you can read in section "Voice-Over” (view page 110) in chapter 
“Sound FX“! 

Surround Editor 

Opens the Surround Editor. 

More on this you can read in section“Surround Editor” (view page 103) in 
chapter  “Sound FX”! 
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Create Surround Transitions 

Creates a surround transition. 

More on this you can read in section “Surround Transitions (view page 104)” in 
chapter “Sound FX”! 

Object FX Editor 

This opens the Object FX page for the selected object. 

More on this you can read in chapter “Cleaning FX (view page 81)!“! 

Load/save real-time effects 

Effects settings can be saved or loaded here as "Mastering" or "Cleaning" FX 
presets in order to apply them to other projects or objects.  

The FX presets can be applied from the Object FX window for individual 
objects as well as Master FX set for the whole sound (in the main screen). 

Because the available object effects are discerned from the master effects, 
some settings may be ignored. For example, the echo/reverb setting is 
ignored when the FX preset is loaded as a Master FX from the main screen, 
because there is no echo/reverb device in the Master FX section. 

Apply all realtime effects 

If the effects settings become too full to manage or you just want to 
"summarize" your production, use this function to convert the entire audio 
arrangement into a single audio file. It will appear as a long object in a new 
project.  

Once the effects have been added they will no longer require CPU power. 
Therefore, of the system monitor reaches the red area but you still require 
CPU-intensive plug-ins, you can use this function to release CPU power. 
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Effects menu 

Here you will find all effects of the "Cleaning" and "Mastering" tabs, as well as 
other effects in submenus, which are sorted according to different topics. 

There is one decisive difference between the effects of the master track and 
the Object FX page and the ones accessed via the "Effects" menu: in the latter 
case, a copy of the original file is produced in WAV format, and the ending _fx 
is added to its name. The effect is added to it directly. 

The advantage is that the effect does not have to be calculated during 
playback and burning, which saves computing power. The disadvantage is 
that the effect's settings can't be changed later. However, since you are 
working with a copy, the Undo (view page 135) function is available, in case 
you made a mistake. 

Just as was the case with the effects of the Object FX page, the effects don't 
affect the entire audio material of the master track, but only the selected 
object. 

A description of the effects which are not explained in what follows can be 
found in the sections Cleaning effects (view page 69), Mastering effects (view 
page 86), and Additional sound effects (view page 103). 

Normalize object volume 

This function raises the volume of an object to the maximum level without the 
material being clipped. This utilizes the dynamic range the best way possible. 
First the highest levels are detected, and then the object level is adjusted so 
that the max. level amounts to 0 dB, i.e. the maximum volume (or another 
value between 1% and 400%). 

Note: If you experience very slight clipping during recording and then proceed 
to normalize the material, then you won't achieve the same quality as if you 
produce a correctly clipped recording! For example, if you only modulate half 
of the material, then your recording will have a quality of 15-bit samples – 
normalizing to 100% doesn't change anything. 
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Normalize to: Here you can set the value to which the audio material should 
be normalized by entering it into the input field, moving the fader, or selecting 
one of the presets (50, 95, 100 or 200%). The value will be shown in % and 
dB (100% = 0 dB = max.). Values above 0 dB bring about digital clipping. 

Maximum level: Displays the highest detected peak in the selected 
range/object. 

Level change: Displays the level change in dB, in accordance with the 
selected normalize level and the detected maximum level. 

Different methods can be specified under "Selection": 

Normalize the selected object only: Normalization is only applied to the 
selected object. This function can also be executed in "Object FX" mode by 
clicking the "Auto" button below the volume controller (always normalizes to 
100%). 

Normalize all objects separately: Each object in the project is normalized 
according to its own maximum (peak) level. The level ratios between the 
individual objects changes for this reason. 

Normalize all objects as a single unit: The maximum level is detected for all 
objects in the project, and each object is normalized according to that value. 
The level ratios between the individual objects is preserved, but only the 
object that contains the maximum level is optimally clipped. 

Start loudness adjustment (RMS normalization): Starts normalization 
including the average loudness (RMS) of objects, see Loudness. 

Keyboard shortcut:  N 
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Adjust volume 

This function unifies the volume of the individual tracks in the project. First all 
of the levels for every object are increased separately to the maximum without 
clipping the material (see Normalization (view page 139)). Depending on the 
musical production, however, each title may have a different volume at full 
level, since the relation between loud and quiet sequences within the track 
also influences how we perceive volume. In the second step, the average 
volume (RMS) of the song is determined and the object level is adapted 
accordingly. 

Tracks with higher peak values but lower loudness may be normalized at a 
level above 0 dB (full clipping). To avoid overloads, the limiter is automatically 
activated (see MultiMax). 

A target loudness (RMS) can be given in dB. Since this is the average value, 
the loudness value is always less than 0dB; -15 is the preset. 

The degree of adjustment decides how strictly the loudness normalization is 
applied. At 0%, no adjustment is made to the target RMS. At a value of 50%, 
the level is raised to half the difference between the detected loudness and 
the target value. Volume differences remain between the tracks in this case. At 
100%, the loudness of every track is raised to the RMS value. This is only 
recommended in seldom cases, since even in a single party mix, a dance hit 
will not have the same volume as a ballad. 

Tip: Volume fluctuation within a song can be balanced with the MultiMax 
leveler presets. 

Keyboard shortcut:  Shift + N 

Isolate Stereo Channels 

Displays a stereo file from two mono objects. The two mono objects are totally 
independent, are located one above the other on two tracks and can be 
worked on separately. This option is particularly suitable for removing 
undesirable audio interference that can only be heard on one channel. 

Switch channels 

This function switches the left and right stereo channels.  
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This is useful for correcting recordings with switched channels. This function 
can be reversed if you don't re-select the range; opening it again will bring 
back the original material.  

Invert phase 

The sample data is inverted along the amplitude axis, which means that 
negative values become positive and vice versa. This function allows you to 
adjust recordings with different phases to one another. 

An incorrect phase occurs if during an analog recording parallel cables are 
switched. To correct such errors, some mixers have a switch that can be used 
to invert the phase of an input. If you press the switch by mistake, errors 
might occur as well. 

This function is reversible, so if you repeat it, the original signal is restored. 

Backwards 

When Backwards is applied the sound file will be played in reverse. This way 
you can create very interesting effects, not to mention the “hidden messages” 
in many songs... 

Plug-ins 

With this dialog you can use Microsoft's DirectX-compatible plug-ins for effect 
calculation in MAGIX Audio Cleaning Lab MX. This allows you to use almost 
any effect algorithm from 3rd-party producers. 

The difference between these plug-ins and those in the mastering section is 
that here (as with the other effects in the "Effects" menu) the effects do not 
occur in real time. That's why here you can use plug-ins which can't be 
applied in realtime due to lacking compatibility or system resources. 

Keyboard shortcut:  X 

For more information, please read the chapter "Mastering effects" (view page 
97). 
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CD/DVD menu 

The CD/DVD menu contains all special functions for audio CDs, DVDs and the 
CD/DVD mastering processes, e.g. setting CD tracks and subindexes as well 
as the "Create CD" function. 

Set track marker 

Allows you to set a track marker at the current location of the position line. All 
the following markers will automatically receive a corresponding number. Each 
CD track needs a track marker. The minimum length for a track is 4 seconds, 
whereas the maximum length of a track is only limited by the capacity of the 
CD. 

Keyboard shortcut:  m 

Set Pause marker 

This function lets you set pause markers. At these points some CD-Players 
switch to absolute silence during playback until the next track marker 
appears. The CD-player displays a countdown for the next title. 

Keyboard shortcut:  Shift + m 

Set track markers automatically 

Use this function to set Track markers automatically by analyzing the audio. 

For more information read the "Automatic track recognition (view page 66)" 
section in the "Editing in the track view" chapter! 

Keyboard shortcut:  Ctrl + m 

Set track marker to object edges 

A track marker is set at every object start.. 

Keyboard shortcut:  Alt + m 
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Split objects at marker positions 

This function will split all objects at the position of the track markers. 

Keyboard shortcut: Strg + t 

Set auto pause length 

Audio files that have been loaded successively into MAGIX Audio Cleaning Lab 
MX are arranged consecutively in the project. Between the tracks, a standard 
pause of 2 seconds is preset. In this dialog, the value can be modified. 

Delete marker 

This function deletes a track or pause marker. To select a marker, you have to 
place the position line to the marker position by clicking on it. 

Keyboard shortcut:  Del 

Delete all markers 

This function removes all existing track and pause markers. This can be useful 
if you are going to use the "Set track markers automatically." function. 

Keyboard shortcut:  Ctrl+Del 

Delete CD track 

This command deletes a selected track marker and the corresponding audio 
material from the position of the track marker to the next track marker. The 
audio material following it, is moved closer. 

Keyboard shortcut:   Alt + Del 

Create CD... 

See "Make CD/DVD (view page 114)" dialog in "Export Section" chapter. 
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Show CD-R drive information 

This dialog shows you all available information on the active CD-writer. This 
includes the manufacturer, product name, product revision, cache and the 
features supported by the drive. 

Show CD-R disc information 

Displays all available information on the CD inserted in the drive. The most 
important feature is the maximum length, which cannot be exceeded during 
production, for example: 74 minutes and 59 seconds. 

Create audio DVD 

MAGIX Audio Cleaning Lab MX also burns DVDs, and there are essentially two 
different types of DVD that are possible:  

Stereo DVD: These are normal video DVDs that can be 
played on any DVD player. Since they don't contain any 
video data, there is more room for the audio data. This can 
be stored either in CD quality with 16 resolution or in 
high-resolution 24 bit audio.  

Surround information is encoded as two-channel stereo audio (Dolby 
Surround ProLogic compatible) 

4 channel DVDs: These are so-called "audio DVDs" and 
require a special DVD player for playback. Music is 
recorded in true 4-channel Surround sound for these 
devices, and 16 or 24 bit resolution is also available in this 
case. 

Burning 24 bit DVDs is only sensible, if the original audio material was also 
recorded in 24 bit quality. 

Depending upon the format, different project lengths are possible. 

DVD video 16 bit: 6h 33 min 
 24 bit: 4h 23 min 
DVD audio 16 bit: 3h 36 min 
 24 bit: 2h 24 min 
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CD track list/ID3 editor 

In this dialog, all the CD tracks in the 
current project are displayed in a list. 
Every track can be given a name 
which is then shown in the master 
track. In addition, you can attach 
further information such as artist, 
album, year and genre. This will then 
be listed in the ID3 tags of the files 
when exporting to MP3. The data is 
used by database and search 
functions in programs like MAGIX 
Music Manager. 

You can identify unknown titles based 
on their sound properties with the 
audioid online track query within an 
online database. See audioid (view 
page 149) for more information. 

By choosing all tracks on the list, the 
corresponding objects are selected 
and the playback position placed at 
the track marker. The sequence of the 
tracks can be adjusted by using the 
"Move" button.  

Track start: Displays the start time of the track, which can also be entered 
numerically. In the gray area next to the number, you can select the unit of 
measurement. The CD track list can be used for fine tuning the track markers. 
Track markers can be moved around directly in the track window by using 
Alt+ arrow buttons or by clicking and moving the mouse cursor. 

Track name: Enter the name of the track here. 

Move track: With the arrow buttons you can rearrange the sequence of the 
tracks and their corresponding objects. 

Delete track: The track (marker and the corresponding objects) will be 
removed from the project. 

Track name/artist/album/year/genre: More details about the tracks (ID3 tags). 
Use "All" to apply the entry to all tracks in the project. This way, you can 
standardize different spellings of an artist, which are imported from different 
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MP3 files, for instance. Use "Write ID3 tags in original file(s)" to write this 
information back into the loaded MP3 file. 

Keyboard shortcut:  l 

MAGIX Xtreme Print Center 

MAGIX Audio Cleaning Lab MX contains an easy-to-use CD print studio. Here, 
you can design and print not only simple track listings, but also sophisticated 
CD covers, CD booklets, and circular CD labels. The track information is 
automatically transferred from the playlist to the print studio. The print studio 
can be found in the "File" menu under > "Print Studio…". 

Get CD track information (freeDB) 

By online freeDB query you can get complete title informations for an imported 
CD from the internet. The query is based on the exact combination of title 
lengths in a given order for a number of tracks. This is also working with 
tracks separately loaded into the the project (as MP3 files, for instance). The 
single play times of the tracks can even differ by some seconds, mostly the 
correct CD is recognized anyway. 

Just put your Audio CD into the disc drive and select "Get CD track 
information (freeDB"). 

CD info options 

Here you can start different advanced options for "freeDB CD Database". 

freeDB > Submit CD to freeDB 

You can add CDs in the online CD database. The enormous freeDB project 
exists courtesy of the contributions made by worldwide users. 

If you have a CD that is not in the database, you can enter the CD information. 

 Make sure the right CD is in the drive. 
 Select "Enter New CD in freeDB " 
 Enter the information, double-checking the details for possible errors. 
 Press "OK" 
 Within an hour or two, the new information will be online for everybody to 

access. 
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freeDB user preferences 

User info is entered here for MAGIX Audio Cleaning Lab MX to use when 
freeDB is queried. Of course, using freeDB is completely anonymous, but 
freeDB often has to process several queries at once, so an i.d. is assigned to 
identify the user. If you have problems accessing info, maybe someone is 
using the same data; you can change the settings to avoid this problem. 

freeDB proxy options... 

If you are having difficulties connecting to the freeDB server, then you can 
choose another server from the list, or you can increase the "timeout" value. 
An increased work load causes the server to react slowly and a connection 
cannot be made properly. 

freeDB > Delete freeDB Cache 

The freeDB online database creates a cache on your hard disk, containing all 
data available via the freeDB button. This allows you to access the data 
without having to go online. You can of course delete the cache, should it 
contain false data or when up-to-date current data is available. 

Open CD track list online 

When recording cassettes or records onto your computer, one large file is 
created in which all tracks are arranged one after the other without track 
markers, much like a CD. You can, of course, use the function "Set track 
marker automatically" to analyze the audio material and, with the help of the 
pauses, separate the file into individual tracks. This does not work, however, 
when the tracks run into one another without a pause. 

In this case you can ascertain the exact track division by querying the Online 
freeDB CD database. To do so, proceed as follows: 

1. Start up your Internet browser and go to the freeDB search page by 
pressing the "Start Internet search" button. 

2. Enter the name of the album or band into the search field. One or more 
albums, which match the search request, are listed. If you know that a 
certain album fits your recording, then click on "Details". It will display the 
CD track list you were looking for alongside other details. 

3. Click on the link above the disc ID (a combination of 8-digits of 
numbers/letters, e.g. 7e120419). freeDB data record  is displayed for this 
CD. 

4. Copy the URL (Internet link) from the address bar of your browser onto the 
clipboard. 

5. Change back to MAGIX Audio Cleaning Lab MX and enter the Internet link 
into the text field in the lower portion of the dialog. Then click on "Apply CD 
data". The CD tracks will be added to the project. 
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Warning: Sometimes the first track may begin very quietly (for instance an 
intro or applause in live recordings) and the start of the recording occurs too 
late. Due to this, it may happen that the length of the first track does not 
correspond to the track length suggested by the database. As a result, all 
track markers will be a little bit too far back. In this case, move the second 
track marker forward while holding down the Ctrl-key; all subsequent track 
markers will then be moved by the same amount and should be positioned 
appropriately at the start of each track. 

audioid 

With this function you can identify audio files. As opposed to the freeDB 
search, the audio file doesn't have to make up part of an album or CD, it 
doesn't even have to be a complete recording. 

MAGIX Audio Cleaning Lab MX analyzes parts of a song's typical sound 
characteristics and sends this information to an Internet server. The server 
then compares this "acoustic fingerprint" with song information in its database 
and responds with the track information. 

You can apply this function either onto the selected object, onto the object at 
the current playback position or onto the object within the project. 

An Internet connection is necessary. If you have a personal firewall, you may 
have to adjust the settings so that MAGIX Audio Cleaning Lab MX can access 
the Internet. 
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Options menu 

Move mouse mode 

 
The shift mode is preset. It allows you to handle all-important tasks:  

Select objects in the track window with a left-click. Selected objects can be 
moved or deleted in move mode. All subsequent objects are also moved so 
that no unwanted gaps develop later in the track. The object can be removed 
from the track with the Del key. All subsequent objects are moved so that no 
gaps occur.  

In move mode you can use the 5 handles to fade or shorten all objects or to 
change the master volume. 

Right-clicking on an object opens the so-called context menu from which you 
can select important editing options for the object. 

Keyboard shortcut:  V 

Cut Mouse mode 

 
The cutting mode converts the mouse pointer into scissors. Every 
object can be cut on the mouse position.   

This creates two separate objects that can be edited separately.  

Moving the mouse over the wave form depiction of the audio material you 
move the Position Bar along with the mouse pointer. So you can control 
exactly the point where you want to cut. The perform precision editing we 
recommend zooming the wave shape display before using the cut mode. 

Like in move mode, right-clicking on an object opens the so-called context 
menu from which you can select important editing options for the object. 

This mode is suitable for dividing a recording into different parts in order to 
apply object effects to each of the passages.  

Keyboard shortcut:  H 
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Zoom mode 

Right mouse button: Zooms out of the project. 
Left mouse button: Zooms into the project. 

Delete Mouse mode 

  

The "Delete Objects" mode turns the mouse pointer into an eraser. In 
this mode you can delete objects from the project. 

Following projects are drifted automatically with the Track Markers in the 
position of the deleted object. 

In Move mode you can also mark an object and press the Del key on the 
keyboard to delete it.  

Keyboard shortcut:  O 

Resampling/Timestretch mouse mode 

 
This mode lets you change the playback speed of objects with the 
mouse so that they are better aligned. 

You can use this mouse mode by stretching or squashing the object at the 
rear object handle below. The mouse cursor turns into a clock. 

Resampling mode (preset) can be used to change speed and pitch just like on 
a tape, i.e. speed and pitch are changed together as one. If an object is 
compressed with the mouse, the speed and pitch increase just like a tape 
when it is played faster. 

In the timestretch mode, the pitch remains unchanged, if the object length and 
with it the speed are changed. 

You can switch modes by opening the Object FX page (view page 64) of an 
object, switching to the cleaning effects, and then selecting timestretching 
from the tempo/resampling effects presets list. 

Draw volume curve mouse mode 

 
With the Draw volume curve mode you can "draw" any volume curve 
using the mouse. 
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This way, you can create irregular volume progressions quickly. 

To delete volume curve points, double-click on the corresponding point or 
click on a point in the erase object mode (view page 38). You can delete 
multiple points by holding the Shift key and clicking the first and last points so 
that all points in between are selected.  

Selected volume points have a blue frame. You can now delete the points with 
the Delete key. 

2 tracks 

 
You can use the "Double track" button to create a second stereo track 
for your background music.  

All objects can be moved randomly between the tracks. If moved between 
tracks while holding the Shift key, the horizontal position will be retained, i.e. 
only the track is changed. 

Important: On the lower track you can move the objects without moving the 
subsequent ones as well. Therefore, if you want to exchange objects, you 
should do this in the second track. 

Keyboard shortcut:  2 

Stereo display 

Using this option you can switch the view of the wave shape, which splits up 
the material between the two stereo channels. This view is useful to visually 
control the material in the stereo panorama or to find zero-crossings for 
cutting operations. 

Keyboard shortcut:  Tab 

Surround Mode 

See "Surround Mode (view page 103)" in the “Sound FX”chapter ! 

Activate Volume Curves 

Activates volume curves (view page 64). 
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Play parameter 

This menu opens the window with the playback parameters. 

  

Sample rate: Here you can adjust the play rate, if the sound card allows so. 

Device: Here you can adjust the sound cards driver, which is in charge of 
playback, provided that the sound card allows this. This becomes especially 
important if there are several sound cards in the computer. 

?: Here the supported audio formats of the sound card, as well as the sound 
card driver's information can be displayed. Furthermore you can switch 
between driver types (MME and WDM). Adjust this setting only if you have 
problems with audio playback or recording. 

Autoscroll: Here you can activate a feature that is especially useful when 
working with long projects: the graphic turns over when the Position Bar 
leaves the visible part. So you never lose the overview. The scroll operation 
requires a certain calculation time (depending on the processor, the graphic 
chart and the resolution), so that the computer can become overloaded in 
critical cases, which produces dropouts during playback. In this case, 
deactivate the auto-scroll mode. 

Smooth / turn over: You can choose between scrolling down a page or page 
turning.  

Playback Buffer: To allow a smooth playback of a complex project, the 
MAGIX Audio Cleaning Lab 11 sets out a data buffer, into which current data 
areas are loaded. Hence, the whole project with all of its adjustments is 
calculated in a step by step procedure. 
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You can determine the size of the buffer in "buffer adjustments", which will be 
used for the playback of the whole arrangement or for the pre-listening of 
waves in the data manager. 

A rule of thumb: in the case of long waiting and loading times, the buffer 
should be reduced; in the case of drop-outs or erroneous real time calculation 
of effects, the buffer should be extended. 

Loop time: Here you can adjust the length of the endless loop, which will be 
used to play the project with activated loop mode. The loop mode itself is 
activated in the transport control (please see the "control consoles (view page 
40)."chapter). 

Keyboard shortcut:  P 

Analyzer window 

This command shows and hides the Analyzer window (view page 42). 

Keyboard shortcut:  Y 

Video window 

Show/hide the video window (if a video file is loaded (view page 128)). 

Units of measurement 

This sub-menu allows you to determine different units for the timeline. You can 
choose between samples, milliseconds hour/minute/second and CD frames. 

Keyboard shortcuts: 

Samples    Shift + 1 
Milliseconds Shift + 2 
h:min:sec Shift + 3 
Min:Sec:CD frames  Shift + 4 

 

Mouse Grid Active 

The mouse grid ensures that the objects, Handles and Markers cannot be 
moved accidentally. If activated, changes are made only if the movement of 
the mouse exceeds a certain minimum distance. If you want to work with a 
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high precision without having to zoom in, you can deactivate this safety 
measure here. 

Auto crossfade mode active 

With every cut the two objects that are created are slighlty crossfaded in order 
to avoid crackling. This is referred to as "Auto crossfading" (for more info on 
crossfades please also see Crossfading objects (view page 63)). As all 
recorded and imported objects can be easily faded  – which is not always 
desired – this option can be deactivated. 

Display values scale 

The right edge of the track view shows a values scale. This indicates the level 
of waveforms in dB, and the spectral display indicates specific frequencies in 
Hz. 

Options for automatic track marker recognition 

In this dialog you set the options for the function "Set track markers 
automatically" For more information read the "Automatic track recognition 
(view page 66)" section in the "Editing in the track view" chapter! 

Minimum length of pauses: This is the time that the audio material must 
remain below a certain level in order to be recognized as a pause. The longer 
this value, the fewer pauses will be detected. If the value is shorter, there is a 
possibility that short silent sequences in a title might be recognized as a 
pause. 

Minimum length of tracks: A new pause will only be recognized once this 
amount of time has passed since the last track marker. If you are recording a 
tape with a pop song and want to write it on CD, you can set this value to 3 
minutes. But if the tape contains short sound samples, the value has to be 
consequently much shorter. 

Maximum level for pauses and Minimum level for pauses: During the first 
step, the program searches for a suitable volume level for the pause 
detection. With these two parameters, you can limit the results before the 
process continues. If too many pauses were detected, then you should move 
both sliders more to the right. In the opposite case, move them to the left. 

Detection of LP and cassette sides: In certain occasions you might want to 
record both sides of an LP immediately one after the other, without 
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interrupting the recording at the computer. The result is normally a very long 
audio file that includes a very silent passage in the middle of the recording (the 
moment when you turned the LP or CD over). The program detects this as 
only one section and splits the object into two new objects and tries the same 
with both of the resulting objects. In the best case, even the noises produced 
while turning the LP or cassette over will be eliminated. You can increase the 
precision of this process, adjusting the minimum length of the side of your LP 
or MC. Here are a few proposals: 

Single:   10 minutes 
LP:   15 minutes 
60 min MC:  25 minutes 
90 min MC:  40 minutes 

Path settings 

In this dialog, you can set the memory path for your recorded audio files (New 
projects) as well as the search path for VST plug-ins. 

Show start selection 

 

Each time the program starts, it will show the start selection and offer presets 
for the most important program applications. 

After choosing an option, a new, empty project (view page 59) and the right 
presets for all cleaning and mastering effects installed according to their 
individual applications will be added. This means, you will only have to activate 
them. On top of that, the settings for the automatic track recognition (view 
page 66) during the recording will be applied according to the chosen 
applications. 
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Furthermore, you can also reload the previous project or view the introduction 
video. 

If you do not wish to use any defaults, you can just close the dialog by clicking 
on the "Close" button in the right-hand corner. When you activate the box 
"Don't show this dialog again", the start selection will not pop up the next time 
you start the program. You can reactivate this at any time via the menu 
"Options" >"Show start selection". 
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Tasks menu 

In this menu all the most important tasks can be selected with a simple mouse 
click.The selected effect opens to help you attain not just fast and professional 
results, but also to learn more about the most appropriate applications of the 
many effects available.  

"Share" menu 

The Share menu provides access to online social networks as well as transfer 
functions to other MAGIX programs.  

Here you'll find options for uploading individual objects in the Arranger or files 
from the Media Pool as well as the entire arrangement, as audio or video. You 
can also transfer your arrangement to another MAGIX program (if it is installed) 
in order to, for example, use it as background music for your slideshow. 

Community upload 

The menu entries featured under "File" > "Export" >"Community upload" or via 
the Export assistant allow you to upload the finished song to different web 
communities. 

Use as background music 

Converts the project into MP3 and forwards it directly to a MAGIX video 
editing program (e.g. MAGIX Movie Edit Pro deluxe MX) where it can be used 
as background music.  

Note: This function is only available if you have installed an appropriate MAGIX 
program.  

Add to music collection 

Converts your arrangement into MP3 format and sends it directly to a MAGIX 
music management program (e.g. MP3 deluxe MX), where it is added to an 
existing music collection.  

Note: This function is only available if you have installed an appropriate MAGIX 
program.  
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Help menu 

Help 

Open the program's help file. The help file provides explanations of all 
functions in the program and step-by-step instructions. 

Keyboard shortcut:  F1 

Display tips 

Determines whether the tooltips are displayed or not. If activated, a small help 
window will be displayed as soon as you hold the mouse over a button for a 
while. 

Show tutorial videos 

MAGIX Audio Cleaning Lab MX comes with several tutorial videos for fast 
access. You can play them via this submenu.  

System information 

Information on the current date and time appear in this Information window, in 
addition to the number of files that have just been opened, the total size of the 
memory in the system and the size of the memory used by the MAGIX Audio 
Cleaning Lab MX. In short, a list of all available drives and their available 
memory capacity. 

About MAGIX Audio Cleaning Lab MX 

Copyright notices and version numbers are displayed. 

Register online 

This option opens the MAGIX homepage for online registration where you can 
register yourself as a MAGIX user.  

Registration grants you access to the MAGIX support website 
http://support.magix.net (see support) where various program updates and 
help programs can be downloaded.  

http://support.magix.net/�
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With the registration form supplied (start menu under "MAGIX Audio Cleaning 
Lab MX -> Service and support -> Register") you can register via post or fax. 
Simply print it out, fill it in, and send it off! 

Keyboard shortcut:  F12 

Update check 

Links directly to the MAGIX online service page (for registered users only). This 
automatically patches and updates your MAGIX Audio Cleaning Lab MX 
version.  

Restore original program settings 

Use this function to reset all program settings you made in MAGIX Audio 
Cleaning Lab MX to their original settings. 

Activate MP3/AAC encoder 

With this menu command you can activate export as AAC or MP3 formats. 

Why does it have to be "activated"? 
To import (decode) or export (encode) certain video and audio formats, you 
will require a specific codec. MAGIX Audio Cleaning Lab MX will ask you if you 
want to activate the codec as soon as you need it. The integration of 
decoders and encoders from third parties into programs usually costs money. 
These codecs are integrated via additional, voluntary activation in MAGIX 
programs which, according to usage and degree of prevalence, can be free or 
fee-based for special high-quality codecs. This way, MAGIX can continue to 
offer you good value for your money. 

The following activations are available on MAGIX Audio Cleaning Lab MX for a 
small fee: AAC encoder. 

Activating the MP3 encoder is free of charge. 

Free activation (MP3) 

To be able to use the MP3 or MP3 surround encoder (audio export), you will 
have to activate it for free first. 

Activation can be done online via telephone or via post/fax. The quickest and 
easiest way to order an activation code is via the Internet. 

Order activation code online 
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Click on "Order online..." (Field 1). Your Internet browser will open. Once you 
have registered, the activation code will be sent to the email address you 
supplied upon registration. 

If your computer has no Internet access, you have the following options for 
activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has 
Internet access. 

Order activation code via telephone 
The telephone number and necessary details you will need to call to receive 
activation by telephone are displayed here. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2), your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on 
"Continue to order form" to transfer your user code automatically to the 
post/fax form. Now send the completed form as a print out to the address/fax 
no. mentioned.  Your activation code will be sent to you in just a few days via 
post or fax. It can also be sent by mail if an email address is state d. 

Enter activation code 
After receiving your personal activation code, you can use the activation dialog 
for the corresponding file format to start exporting for the respective format. if 
you receive the activation code via email, then copy it into the input field in the 
dialog and click  "Activate...".  

Fee-based activation (MPEG-2) 

To be able to import video sound from MPEG2 videos, the corresponding 
codecs must be activated first (fee-based). 

Order activation code online 
Click on "Order online..." (Field 1). The web browser will open for you to 
register MAGIX Audio Cleaning Lab MX first (if you have not already done so). 
You will then be forwarded to a website where you can request the 
corresponding activation. 

If your computer has no Internet access, then you have the following options 
for activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has 
Internet access. 

Order activation code via post/fax 
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After clicking on "Order via post/fax" (field 2) your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on 
"Continue to order form" to transfer your user code automatically to the 
post/fax form. Now send the completed form as a printout to the address/fax 
no. mentioned.  Once payment has been processed successfully, your 
activation code will be sent to you in the post/via fax in just a few days. 
Optionally, it can also be sent by email if an email address is stated. 

Enter activation code 
After receiving your personal activation code use the export or burn function 
to reopen the activation dialog for the corresponding file format. Type or copy 
the activation code into the input field in the dialog and click on "Activate...". 

Fee-based activation (AAC) 

In order to export as AAC format, activation of the encoder is required: 

Activation is fee-based and can be done online or via post/fax. The quickest 
and easiest way to order an activation code is via the Internet. Ordering the 
activation code takes just a few minutes via email. The order of your activation 
code via post/fax takes a few days.  

Order activation code online 
Click on "Order online..." (Field 1). The web browser will open for you to 
register MAGIX Audio Cleaning Lab MX first (if you have not already done so). 
You will then be forwarded to a website where you can request the 
corresponding activation. 

If your computer has no Internet access, then you have the following options 
for activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has 
Internet access. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2) your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on 
"Continue to order form" to transfer your user code automatically to the 
post/fax form. Now send the completed form as a printout to the address/fax 
no. mentioned.  Once payment has been processed successfully, your 
activation code will be sent to you in the post/via fax in just a few days. 
Optionally, it can also be sent by email if an email address is stated. 

Enter activation code 
After receiving your personal activation code use the export or burn function 
to reopen the activation dialog for the corresponding file format. Type or copy 
the activation code into the input field in the dialog and click on "Activate...". 
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Activation problems 

Problem: The entered code is incorrect (telephone activation) 

Make sure your entry is correct; in most cases a typo is to blame. 
If the code is entered correctly, dial the number of our Call Center. Our 
support staff will help you personally. 

The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

 Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

 Check that your inbox isn't full. 
 Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. 
Please have the following information at hand so that we can assist you as 
quickly and as specifically as possible. 

 Complete product name 
 Exact version number (to be found in the about box in the "About" menu item 

of the "Help" menu) 
 Encoder/Decoder name 
 Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed MAGIX Audio Cleaning Lab MX on a new computer, 
installed a new hard drive in my old computer (sound card, memory...), or 
installed it multiple times on the same computer. My activation code is no 
longer accepted! 

If the program cannot be activated again after it has been activated multiple 
times, please contact the MAGIX customer service (view page 12). 
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Keyboard layout and mouse-wheel support 

Keyboard layout 

Menu functions 
New project E 
Load project O 
Save project S 
Save project as Shift + S 
Load audio file W 
Load audio CD track(s) Shift + D 
Recording  R 
Export audio (Wave) K 
Batch conversion Shift + B 
Load video sound J 
Save video sound G 
Finish Alt + F4 
Undo Ctrl + Z 
Redo Ctrl + Y 
Set marker Alt + M 
Remove object beginning D 
Remove object end U 
Split T 
Cut Ctrl + X 
Copy Ctrl + C 
Paste  Ctrl + V 
Remove (delete) Del 
Normalize object volume N 
Adjust volume Shift + N 
Spectral Cleaning Ctrl + D 
Plug-ins X 
Object FX editor Ctrl + O 
Set track marker M 
Set pause marker Shift + M 

Set track marker automatically Ctrl + M 
Set track markers on object edges Ctrl + Shift + M 
Split objects at marker positions Ctrl + T 
Remove all markers  Ctrl + Del 
Delete CD track Alt+Del 

Make CD B 
CD track list/ID3 editor L 
audioid Shift + U 
Move mode  V 
Cut mode  H 
Zoom mode Z 
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Delete mode  F 

2 tracks 2 
Stereo display Tab 
Playback parameters P 
Units of measurement Shift+1..4 
Mouse grid active  Ctrl + R 
Display values scale #, ' 
Help  F1 

Transporter functions 
Playback/Stop  Space bar 

Play as loop Shift + space bar  
Pause , 
"Emergency stop" during playback Esc 
Back to the beginning Home 

To the end End 

Fast forward (rewind) Arrow left (right) 
Playback position to next (previous) track 
marker  

Alt + arrow left (right) 

Playback position to the next (previous) object 
edge  

Shift + Alt + arrow left (right) 

Keyboard shortcuts for zooming the display, please see Zoom commands 
(view page 43). 

Mouse-wheel support 

Middle mouse button Start/Stop playback 
Mouse wheel Scroll horizontal 
+ Ctrl Zoom horizontal 
+ Shift Zoom vertical 
+ Ctrl + Shift Scroll vertical 
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Backwards................................................................................................. 142 
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CDs..............................................................................................................55 
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DeNoiser ......................................................................................................77 
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Distortion ................................................................................................... 109 
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Drive list dialog .............................................................................................57 
Duplicate objects..........................................................................................60 
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Edit Menu................................................................................................... 135 
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Energizer (plug-in)....................................................................................... 100 
Enhancer......................................................................................................87 
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Exit ............................................................................................................ 134 
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File Menu ................................................................................................... 125 
Find media ................................................................................................. 133 
Format settings .......................................................................................... 112 
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Help ...........................................................................................................159 
Help menu..................................................................................................159 
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Import CD ....................................................................................................55 
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Info Box..................................................................................................42, 73 
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Limiter ..........................................................................................................45 
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Load audio CD ...........................................................................................127 
Load audio file ............................................................................................126 
Load project ...............................................................................................125 
Load video sound...............................................................................128, 154 
Load/save real-time effects .........................................................................138 

M 

MAGIX News Center.....................................................................................34 



 

 170 Index  

www.magix.com

MAGIX Online Album .................................................................................. 129 
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magix.info ....................................................................................................15 
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Path settings ......................................................................................133, 156 
Play parameter .....................................................................................45, 153 
Playback ......................................................................................................84 
Plug-ins ................................................................................................97, 142 
Position line ..................................................................................................34 
Preface...........................................................................................................3 
Program start ...............................................................................................19 
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